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Preface

About this Document

This document is part of a document set prepared in support of the
Texas Instruments/Telogy Software TNET Vxxxx x.x product release.

About the Document Set

Various books in the document set will be of interest to developers of voice-over-packet
products according to their role:

» Project Managers

« Hardware Engineers
» Software Engineers
o Test Engineers

« Application Developers

Texas Instruments Silicon and Telogy Software Documents

The following Texas Instruments/Telogy Software-produced documents are provided
with TNETVxxxx Release x.x:

o DSP Module Software Architecture

o MXP Operating Environment Reference GuideMXP Operating
Environment User’s Manual

Document Conventions
This document uses the following conventions:
« Commands and keywords are in boldface font.
« Arguments for which you supply values are in italic font.
o Terminal sessions and information the system displays are in screen font.
» Information you must enter is in boldface screen font.

« Elements in square brackets ([ ]) are optional.
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Preface

Notes use the following conventions:

NOTE—Means reader take note. Notes contain helpful suggestions or references
to material not covered in the publication.

The information in a caution or a warning is provided for your protection. Please read
each caution and warning carefully.

CAUTION—Indicates the possibility of service interruption if precautions are
not taken.

WARNING—Indicates the possibility of damage to equipment if precautions are
not taken.
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Preparations

1.1 Introduction

The exercises in this manual were developed for delivery in a classroom environment
but have been adapted for use in a personal lab environment. Variations in network
configuration, software installation, software version, and Host PC configuration could
result in different outcomes.

1.2 Software

The exercises in this manual require the following software installations:

o Multicore Software Development Kit (MCSDK) Version 2.x or later
o Code Composer Studio (CCS) Version 5.x or later.

For more information, refer to the BIOS MCSDK Getting Started Guide
http://processors.wiki.ti.com/index.php/BIOS_MCSDK_2.0_Getting Started_Guide

1.3 EVM Configuration

All exercises in this manual were designed for use on the TMS320C6678 Lite evaluation
modules from Texas Instruments. While these procedures have not been tested on the
TMS320C6657 and the EVMK2H, they should also work on those devices.

For labs requiring a mezzanine card with a trace emulator, the TMS320C6678LE is
recommended.

TMS320TCl66x Keystone Multicore Workshop Lab Manual (BookID: SPRP820/A) 1-1
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1.3 EVM Configuration

—Preparations DocID: 122222
Before you begin, set the EVM to ‘no boot’ mode as shown in Table 1-1.
Table 1-1 No Boot Dipswitch Settings
DIP SW3 DIP SW4 DIP SW5 DIP SWé6
Boot Mode (Pin1,2,3,4) (Pin1,2,3,4) (Pin1,2,3,4) (Pin1,2,3,4)
No boot (off, on, on, on) (on, on, on, on) (on, on, on, on) (on, on, on, on)
End of Table 1-1

Note—Additional EVM switch settings are available at the following link:
http://processors.wiki.ti.com/index.php/ TMDXEVM6678L_EVM_Hardware
_Setup#Boot_Mode_Dip_Switch_Settings

Procedure 1-1 Create a New Target in CCS

Step - Action
1 Launch CCS by double-clicking the icon on the desktop.

Note—As CCS initializes, a pop-up will appear with a default workspace. Replace the default
workspace with “C:/ti/workspace.”
2 Create a new target configuration:
2a Select the CCS menu option View =2 Target Configurations.
2b Select User Defined.
2c¢ Right-click and select New Target Configuration.
3  Enter the name of the new target configuration in the File Name: text box.
3a Set the File name based on the EVM model, <model>.ccxml
For example, ‘EVM6678LE.ccxml.’
3b Leave the Location the default value:
“C:\Documents_and_Settings\student\ti\CCSTargetConfigurations”

3¢ Click the Finish button. The .ccxml file will now open in a GUI-based view with the Basic tab
active.

4  Define the new target configuration by selecting the connection type in the Basic Tab.
4a Locate your EVM model Table 1-2 and set the properties accordingly.

Table 1-2 EVM Emulator Types
EVM Model Emulator Type Device
EVM6657L Texas Instruments XDS100v2 USB Emulator TMS320C6657
EVM6657LE Blackhawk XDS560v2-USB Mezzanine Card TMS320C6657
EVM6678L Texas Instruments XDS100v1 USB Emulator TMS320C6678
EVM 6678LE Blackhawk XDS560v2-USB Mezzanine Card TMS320C6678
End of Table 1-2

4b The Connection drop-down menu identifies the emulator type, as shown in the table
above. For example, ‘Blackhawk XDS560v2-USB Mezzanine Card.’

4c  Boardor Device identifies the Tl processor device, as shown in the table above. For example,
‘TMS320C6678.

4d Under Save Configuration, click the Save button.

1-2 TMS320TCl66x Keystone Multicore Workshop Lab Manual (BookiD: SPRP820/A)
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1.3 EVM Configuration
DocID: 122222 —Preparations

5  Configure setup on the Advanced Tab
5a Click the Advanced tab at the bottom of the screen.
5b Select Core 0 on the target device:
e« TMS320C6657_0-> IcePick_C_0-> Subpath_1-> C66XP_0
OR
e TMS320C6678_0 > IcePick_D -> subpath_0 - C66x_0

5¢  You will now see a sub-window called Cpu Properties that allows you to choose an
initialization script.

5d Locate the appropriate GEL file, then click Open:
e For EVM6657L/LE, select:
C:\ti\ccsv5\ccs_base\emulation\boards\evmc6657I\gel\evmc6657I.gel
¢ For EVM6678L/LE, select:
C:\ti\ccsvb\ccs_base\emulation\boards\evmc6678I\gel\evmc6678l.gel
5e Click the Save button.

End of Procedure 1-1

TMS320TCl66x Keystone Multicore Workshop Lab Manual (BookID: SPRP820/A) 1-3
Product Release: MCSDK 2.x



1.3 EVM Configuration
—Preparations DocID: 122222

1-4 TMS320TCl66x Keystone Multicore Workshop Lab Manual (BookiD: SPRP820/A)
Product Release: MCSDK 2.x



Chapter 2

CCS Basics (SRIO Loopback)

2.1 Purpose

The purpose of this exercise is to demonstrate how to build and run a very basic Code
Composer Studio (CCS) project on the C6678 EVM. The Direct IO Loopback example
delivered with the MCSDK is used to help illustrate these concepts.

2.2 Instructions

In this exercise, you will import a sample project from the MCSDK into CCS, build the
sample application code, connect to the EVM, load the code, run the application, and
verify the results.

The list of processes used in this example are as follows:
+ Procedure 2-1 “Import the Example Project”
o Procedure 2-2 “Verify and Set Project Properties”
» Procedure 2-3 “Build the Project”
o Procedure 2-4 “Connect to the Target EVM”
o Procedure 2-5 “Load and Run the Program”

Procedure 2-1 Import the Example Project

Step - Action
1 Launch CCS by double-clicking the icon on the desktop.

Note—As CCS initializes, a pop-up will appear with a default workspace.
Replace the default workspace with “C:/ti/workspace”.

Once CCS starts, verify that the perspective is set to CCS Edit.
3  Discover the new packages installed in folders other than C:\ti.
3a Select the CCS menu option Window -> Preferences
3b Inthe pop up window that appears, select Code Composer Studio - RTSC - Products

3c Add the master folder into Tool Discover Path by clicking the Add in the upper right corner

of the pop-up window and select the master folder.
3d For example, select C:\ti\MCSDK_2_1_2_6 to add in the Tool Discovery Path.

3e Click Refresh to update the discovered tools list.
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2.2 Instructions
Chapter 2—CCS Basics (SRIO Loopback) Doc ID: 122222

4  Import the example project as follows:
4a Select the CCS menu option Project > Import Existing CCS Eclipse Project
4b Set Select search directory to locate the example projects available for your EVM:
e (C6657L/LE) C:\ti\mcsdk\pdk_C6657_1_1_2_5\packages\ti\drv\exampleProjects

e (C6678L/LE) C:\ti\mcsdk\pdk_C6678_1_1_2_5\packages\ti\drv\exampleProjects

4c  From the list of Discovered projects, place a check mark in the box next to
SRIO_LoopbackDiolsrexampleproject.

Note—There are multiple SRIO projects with similar names. Verify that the
project you import matches exactly with the name as shown above.

4d Place a check mark on Copy projects into workspace.
4e Click the Finish button.

The SRIO_LoopbackDiolsrexampleproject project should now appear in the CCS
Project Explorer on the left-hand side of your screen.

End of Procedure 2-1

Procedure 2-2 Verify and Set Project Properties

Step - Action
1 In Project Explorer, right click on SRIO_LoopbackDiolsrexampleproject and select Properties.
2 Select General properties.

3 Choose the Main tab and set/verify the Device properties as follows:
« ‘Family = C6000’
« 'Variant = Generic C66x Device’
Select Build properties.
5  Choose C6000 Compiler = Processor Options and set/verify the following properties:
» ‘Configuration = Debug’
» ‘Target processor version = 6600’
» ‘Application binary interface = eabi’

Note—Different version of CCS may have slightly different GUI. The

Application binary interface tab may be part of the main window and not the
processor option window.

Select Build properties.
7  Choose C6000 Compiler = Optimization and set/verify the following properties:
» ‘Optimization level =0’
«  'Optimize for code size = 0’
8  Select Build properties
9  Choose C6000 Compiler = Debug Options and set/verify the following properties:
+  ‘Debugging model = Full symbolic debug’
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2.2 |Instructions
Doc ID: 122222 Chapter 2—CCS Basics (SRIO Loopback)

10  Select Build properties, choose C6000 Compiler = Include Options and ensure that include paths
are setup as shown in Figure 2-1.

Figure 2-1 C6000 Compiler Include Options

Configuration: lDebug [ Active ]

Add dir to #include search path (--include_path, -I)

"${CG_TOOL ROOT}/include"

"${PDK_INSTALL_PATH}/ti/drv/srio/example/SRIOLoopbackDiolsr”

11 Click the OK button to save the project properties and close the Properties window.

End of Procedure 2-2

Procedure 2-3 Build the Project
Step - Action
1 In Project Explorer, select the SRIO_LoopbackDiolsrexampleproject project.
2 Build the project:
o Select the CCS menu option Project = Build Project
OR
« Right-click on the project in Project Explorer and select Build Project
OR
o Click on the hammer icon
3  CCSwill now attempt to compile and link the project. This may take a few minutes to complete.

4  Please direct your attention to the CCS Console. On a successful build, you will see no errors
generated in the Problems window (NOTE: There may be warnings) and the following message
should display in the Console window:

'Finished building target: SRIO LoopbackDioIsrexampleproject.out'
*%%x Build Finished ***x*

QUESTIONS:
Was the file SRIO_LoopbackDiolsrexampleproject.out generated?

Note—From the CCS Edit perspective, check the Binaries or Debug directory.
From the CCS Debug perspective, check the Console.

End of Procedure 2-3
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Procedure 2-4 Connect to the Target EVM
Step - Action

1 Click the Open Perspective (available right top corner of the CCS).
2 Switch to the Debug Perspective by selecting the CCS menu option Window = Open Perspective
- CCS Debug.

3 Connect the power adapter to your EVM, then connect your laptop to the emulator port on the
EVM using the provided USB cable. If you are using the XDS560v2, wait till the solid red light
appears before proceeding to the next step.

Note—The Windows “Found New Hardware Wizard” may pop-up when you
first connect the emulator via USB to the laptop. Select “Yes, this time only” =
Next = “Install the software automatically” = Next, and allow the drivers to
install on your system. Then click “Finish.” You may need to restart CCS at this
point.

4  Select the CCS menu option View - Target Configurations. Your newly-created .ccxml target
configuration file should be available under User Defined target configurations.

5  If more than one target is configured, select the target that you defined, right click and set it as
default
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6  Launch the target configuration as shown in Figure 2-2:
6a Select the target configuration .ccxml file.
6b Right click and select Launch Selected Configuration.
Figure 2-2 Launch Target Configuration

1+ CCS Edit - Source not found. - Code Composer Studio ™ NN

File Edit Wiew Mavigate Project Run  Scripts  Window Help

il RN~ B~ iw P ifE P
P Project Explorer Target Configurations 2 l = B ||[&] abort() at
B ® | & [E|| Can'tfind a

Locate the fi

type filter text

= Projects
4 [= User Defined

EVIMGE38. coxml
KeplerDSP.coxml
KeplerMoGel.ccxml
ShannonSimulator.coxml
Shannon_6678.ccxml
TCIE638. coxml
TLv100.ccxml
TweolMezzanined678, coxml
cBETEMPAXS .coxml

View Disass

Wi

Locate File.,

| %] ewm6678Trace.ccxml [Default]|

evmWithLinux.cor| [2)  New Target Configuration
Import Target Configuration

X

Delete
Rename
Refresh

= 5

Launch Selected Configuration

)
A

Set as Default
Link File To Project

Properties

Delete
F2
F5

Alt+Enter

Lal
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7  This will bring up the Debug window as shown in Figure 2-3.
Figure 2-3 CCS Debug Window for evm6678Trace.ccxml

2 CCS Debug - Source ot found: = Code Composer Studic ™ N

File Edit Wiew Project Tools Run  Scripts Window Help
mifhg v ow| | IR NG
% Debug 22
4 v evmBB7ETrace.coxml [Code Composer Studio - Device Debugging]
;ﬁ’ Blackhawk XD5560v2-USE System Trace Emulator 0/C86:: 0 (Disconnected : Unknown)
;ﬁ’ Blackhawk XD5560v2-USE System Trace Emulator_0/C86x¢ 1 (Disconnected : Unknown)
;ﬁ’ Blackhawk XD5560v2-USE System Trace Emulator_0/C66x:_2 (Disconnected : Unknown)
;ﬁ’ Blackhawk XD5560v2-USE System Trace Emulator_0/C66x:_3 (Disconnected : Unknown)
;ﬁ’ Blackhawk XD5560v2-USE System Trace Emulator_0/C66x: 4 (Disconnected : Unknown)
;ﬁ’ Blackhawk XD5560v2-USE System Trace Emulator_0/C86x:_5 (Disconnected : Unknown)

;.5"3 Blackhawk XD5560v2-USE System Trace Emulator_0/C66x: 6 (Disconnected : Unknown)
x@ Blackhawk XD5560v2-USE System Trace Emulator_0/C66: 7 (Disconnected : Unknown)

7a Select Core 0 (C66x_0)
7b Right click and select Connect Target.
End of Procedure 2-4

Procedure 2-5 Load and Run the Program

Step - Action
1 Select Core 0 and load the .out file created earlier in the lab.

1a Select the CCS menu option Run > Load - Load Program.
1b Click Browse project...
1c A pop-up will appear with the projects names.
1d Select SRIO_LoopbackDiolsrexampleproject
1e Click Debug, then select SRIO_LoopbackDiolsrexampleproject.out and click OK.
1f Click OK to load the application to the target (Core 0).
2 Runthe application by selecting the CCS menu option Run = Resume.
OR
Click on the green arrow.

3 Once the program completes successfully, you will see the message “Debug(Core 0): DIO with
Interrupts example completed successfully.”
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4  Then select the CCS menu option Run = Suspend.

OR

Click on the two yellow bars next to the green arrow

2.2 Instructions

Chapter 2—CCS Basics (SRIO Loopback)

The expected output on the console should appear as follows:

[C66xx 0]

[C66xx_ 0] Debug(Core
[C66xx 0] Debug(Core
[C66xx_0] Debug(Core
[C66xx_0] Debug(Core
[C66xx 0]

[C66xx 0]

[C66xx 0]

[C66xx 0] Debug(Core 0) :
0x@1081b200

[C66xx 0] Debug(Core 0) :

0x@1081c200

[C66xx_0] Debug(Core
[C66xx_0] Debug(Core
[C66xx_0] Debug(Core
[C66xx 0] Debug(Core
[C66xx 0] Debug(Core
[C66xx_0] Debug(Core
[C66xx 0] Debug(Core
[C66xx 0] Debug(Core
[C66xx 0]

[Ce6xx 0]

[C66xx 0]

[C66xx 0] Debug(Core 0) :
0x@1081b200

[C66xx 0] Debug(Core 0) :

Executing the SRIO DIO example on the DEVICE

0) :

System Initialization for CPPI & QMSS

Queue Manager and CPPI are initialized.

Host Region 0x8268f0

SRIO Driver has been initialized

RS SRR E RS RS RS EE RS RS EEEEEEEEEEEEEEEEEEREEEEEEEEEEEEEEESEEEES]

**x**k** DIO Socket Example with Interrupts

(Core 0)

khkkkkkkk

RS SRR RS SRS R RS R RS R RS SRS SRS SRS RS RS E R EEEEEEEES]

Starting the DIO Data Transfer - Src(0)

Starting the DIO Data Transfer - Src(8)

DIO Socket

ISR

DIO

ISR

Count:

Socket

Count:

(0)

1

(2)

9

Send for iteration 0

Send for iteration 2

Transfer Completion without Errors - 9

Transfer Completion with Errors

0

0x@1081b100 Dst (0)

0x@1081c100 Dst (8)

DIO Transfer Data Validated for all iterations

DIO Data Transfer (WRITE) with Interrupts Example Passed

hhkkhkkkkkkhhhkhkkhkhhhhkhkhkhkhhhhhkhkhhdhhhkhkhhhdhhhkhkhddhhkhkhkhdhhhkhkrhhdkx

*%*xx%x* DIO Socket Example with Interrupts

(Core 0)

*kkkkkk*k

RS SR SR RS SRS R E SRS RS E SR RS EEEE SRS EEE RS R SRR EREEEEEEEEEE S

0x@1081c200

[C66xx 0] Debug(Core
[C66xx 0] Debug(Core
[C66xx_0] Debug(Core
[C66xx 0] Debug(Core
[C66xx 0] Debug(Core
[C66xx_0] Debug(Core
[C66xx 0] Debug(Core
[C66xx_0] Debug(Core

Starting the DIO Data Transfer - Src(0)

0x@1081b100 Dst (0)

Starting the DIO Data Transfer - Src(8) 0x@1081cl00 Dst(8)

DIO

ISR

DIO

ISR

DIO

ISR

DIO

ISR

Socket

Count:

Socket

Count:

Socket

Count:

Socket

Count:
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[C66xx 0] Debug(Core 0): DIO Socket (1) Send for iteration 2

[C66xx 0] Debug(Core 0): ISR Count: 17

[C66xx 0] Debug(Core 0): DIO Socket (2) Send for iteration 2

[C66xx 0] Debug(Core 0): ISR Count: 18

DocID: 122222

[C66xx 0] Debug(Core 0): Transfer Completion without Errors - 9

[C66xx_0] Debug(Core 0): Transfer Completion with Errors

-0

[C66xx 0] Debug(Core 0): DIO Transfer Data Validated for all iterations

[C66xx 0] Debug(Core 0): DIO Data Transfer (READ) with Interrupts Example Passed

[C66xx 0] Debug(Core 0): Allocation Counter : 81

[C66xx 0] Debug(Core 0): Free Counter : 72

[C66xx 0] Debug(Core 0): DIO with Interrupts example completed successfully.

End of Procedure 2-5

QUESTIONS:
Using a text editor, look at the CFG file and determine how the project includes

1.

the SRIO module.
a. What other modules are needed?
Hint: QMSS and CPPI are needed for SRIO

b. The CFG file specifies CORE 0 and CORE 1. Is this important to the

execution of the application?

3. Load the OUT file and run it on Core 1.
a. Doesitrun?

b. Look at the main function and explain why.
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Chapter 3

HyperLink Communication

3.1 Purpose

The purpose of this exercise is to demonstrate how to build an application that uses the
HyperLink interface on KeyStone C66x devices.

Note—Not all KeyStone devices include HyperLink. Refer to the data manual
for your device before proceeding.

Note—Not all KeyStone EVMs include a HyperLink interface on the board. An
expansion module may be required. Refer to the Quick Start Guide for your
EVM before proceeding.

3.2 Instructions

Begin by importing HyperLink example code from the MCSDK and running it in
loopback mode on a single C66x EVM. In this example, the same C66x EVM acts as
both the sender and the receiver of packets. Only one C66x EVM is required for this
part of the exercise.

The second part demonstrates the HyperLink connection between two C66x EVMs. As
aresult, this lab requires a second C66x EVM, a HyperLink cable (HL5CABLE), and an
optional EVM breakout card (CI2EVMBOC). One C66xx EVM acts as the sender (Tx)
and the other acts as the receiver (Rx).

The list of processes used in this example are as follows:
« Procedure 3-1 “Import the Example Project”
o Procedure 3-2 “Verify and Set Project Properties”
« Procedure 3-3 “Loopback Mode”
o Procedure 3-4 “Build the Project”
o Procedure 3-5 “Connect to the EVM”
» Procedure 3-6 “Load and Run the Program”
» Procedure 3-7 “Board-to-board HyperLink”
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Procedure 3-1 Import the Example Project
Step - Action

1 Move to the CCS Edit Perspective.
2 Import the example project as follows:
2a Select the CCS menu option Project > Import Existing CCS Eclipse Project
2b Set Select search directory to locate the example projects available for your EVM:
e (C6657L/LE) C:\ti\mcsdk\pdk_C6657_1_1_2_5\packages\ti\drv\exampleProjects

e (C6678L/LE) C:\ti\mcsdk\pdk_C6678_1_1_2_5\packages\ti\drv\exampleProjects

2c From the list of Discovered projects, place a check mark in the box next to
hyplnk_exampleProject

2d Place a check mark on Copy projects into workspace.
2e Click the Finish button.

2f The hypink_exampleProject should now appear in the CCS Project Explorer on the left-hand
side of your screen.

End of Procedure 3-1

QUESTIONS:

Expand the hyplnk_exampleProject folder and double click on hypinkLLDCfg.h to view the file and
answer the following:

1. How many lanes are configured?
2. What is the baud rate? (HINT: 01p250 means 1.25GBaud)

Procedure 3-2 Verify and Set Project Properties
Step - Action
1 In Project Explorer, right click on hypink_exampleProject and select Properties.

2 Select General properties.
3  Choose the Main tab and set/verify the Device properties as follows:
« ‘Family = C6000’
» 'Variant = Generic C66x Device’
Select Build properties.
5  Choose C6000 Compiler = Processor Options and set/verify the following properties:
» ‘Configuration = Debug’
» 'Target processor version = 6600’
« 'Application binary interface = eabi’

Note—In different versions of CCS, the Application binary interface tab is located in the main
tab

Select Build properties.
7  Choose C6000 Compiler = Optimization and set/verify the following properties:
«  'Optimization level = 0’
«  'Optimize for code size = 0’
8  Select Build properties
9  Choose C6000 Compiler - Debug Options and set/verify the following properties:
» ‘Debugging model = Full symbolic debug’
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10  Select Build properties, choose C6000 Compiler = Include Options and ensure that include paths
are setup as shown in Figure 3-1.

Figure 3-1 C6000 Compiler Include Options

Include Options

Configuration: |Debug [ Active ] -

Add dir to #include search path (--include_path, -I)

"${CG_TOOL_ROOT}/include”
"${PDK_INSTALL PATH}"

"SIPDK_INSTALL_PATH}/ti/csl/srcfintc”
"SIPDE_INSTALL_PATH}/ti/drv/hyplnk/example/common”

11 Click the OK button to save the project properties and close the Properties window

End of Procedure 3-2

Procedure 3-3 Loopback Mode
Step - Action
1 Look for the following line in hyplnkLLDCfg.h and verify that it is uncommented.
#define hyplnk EXAMPLE LOOPBACK

When uncommented, this #define ensures that the example runs in loopback mode on a single
EVM.

End of Procedure 3-3

Procedure 3-4 Build the Project
Step - Action
1 In Project Explorer, select the hyplnk_exampleProject project.

2 Build the project:
2a Select the CCS menu option Project - Build Project
OR
2b Right-click on the project in Project Explorer and select Build Project
3  CCSwill now attempt to compile and link the project. This may take a few minutes to complete.

Please direct your attention to the CCS Console. On a successful build, you will see no errors
generated in the Problems window (NOTE: There may be warnings) and the following message
should display in the Console window:

<Linking>
'Finished building target: hyplnk exampleProject.out'
**%%x Build Finished ***x*

End of Procedure 3-4
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QUESTIONS:
Was the file hyplnk_exampleproject.out generated?

Note—From the CCS Edit perspective, check the Binaries or Debug directory.
From the CCS Debug perspective, check the Console.

Procedure 3-5 Connect to the EVM
Step - Action
1 Click the Open Perspective (available right top corner of the CCS).

2 Switch to the Debug Perspective by selecting the CCS menu option
3 Window - Open Perspective - CCS Debug.
4

Select the CCS menu option View - Target Configurations. Select the target configuration you
created

5  Launch the target configuration as follows:
5a Select the target configuration .ccxml file.
5b Right click and select Launch Selected Configuration.
6  This will bring up the Debug window.
6a Select Core 0 (C66x_0)
6b Right click and select Connect Target.
End of Procedure 3-5

Procedure 3-6 Load and Run the Program
Step - Action
1 Select Core 0 and load the .out file created earlier in the lab.

1a Select the CCS menu option Run - Load - Load Program
1b Click Browse project...
1c A pop-up will appear with the projects names.
1d Select hyplnk_exampleProject
1e Click Debug, then select hypink_exampleProject.out and click OK.
1f Click OK to load the application to the target (Core 0)
2 Runthe application by selecting the CCS menu option Run = Resume.

The program attempts to send and receive tokens via the HyperLink interface in loopback
mode. So the same device acts as both the send and receive side.

4 Asuccessful run should produce the following console output for each iteration.
[C66xx 0] Checking statistics

[C66xx 0] About to pass 65536 tokens; iteration = 1

[C66xx 0] === this is not an optimized example ===

[C66xx 0] Link Speed is 4 * 6.25 Gbps

[C66xx 0] Passed 65536 tokens round trip (read+write through hyplnk) in 9278 Mcycles
[C66xx 0] Approximately 141574 cycles per round-trip

[C66xx 0] === this is not an optimized example ===

5  Multiple iterations are performed and the program will go on indefinitely until manually
stopped. Once you have verified that the program has executed successfully, select the CCS
menu option Run - Suspend.

End of Procedure 3-6
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Procedure 3-7 Board-to-board HyperLink

Step - Action
A second C66x EVM is required perform this portion of the lab. You will need a
HyperLink cable and (optional) a 2-EVM breakout card.

1 Modify the example code for hypink_exampleProject so it can be run on two EVMs:
1a Open hyplnkLLDCfg.h
1b Search for #define hyplnk EXAMPLE LOOPBACK
1c Comment out this line

1d Ensure that the baud rate is set to 6.25 Gbaud, i.e. the line #define
hyplnk EXAMPLE SERRATE 06p250 isuncommented.

Build the code, load to both targets, and run the generated out file on Core 0 only.
Modify the example code for hyplnk_exampleProject
3a Open hypinkLLDCfg.h
3b Change the Baud Rate to a higher rate.
4  Build the code, load to both targets, and run on Core 0 only.

Note—The two systems must have the same rate!
End of Procedure 3-7

QUESTION:
1. What is the highest transfer rate that can be achieved using this example?

2. Look at the errata documentation and identify the theoretical limit of HyperLink
transfer. Why is this the case?

Note—The maximum length of the board-to-board connection should be 4
inches. Thus, the physical cable connection is not as efficient as a hard wired
connection.
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4.1 Purpose

The purpose of this exercise is to demonstrate usage of Type 11 SRIO using an example
application imported into CCS from the MCSDK.

4.2 ProjectFiles
The following files are used in this lab:
« biolnclude.h
« bioMain.c
« bioUtilityAndGlobals.c
o device_srio_loopback.c
« ExampleSRIO.cmd
« fftRoutines.c
o gen_twiddle_fft16x16.c
 initialization.c
« masterTask.c
« multicoreLoopback_osal.c
» requestProcessingData.c
o slaveTask.c
« SRIOMulticore_fft 1.cfg

4.3 Instructions

First, you will import the example project from MCSDK to CCS. Next, you will build
an application from the project and load it to the EVM. Finally, you will run the project
and observe the results.

The list of processes used in this example are as follows:
o Procedure 4-1 “Import the Project”
o Procedure 4-2 “Build the Project”
+ Procedure 4-3 “Connect to the EVM”
o Procedure 4-4 “Load and Run”
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Procedure 4-1 Import the Project

Step - Action
1 Open CCS.

2 Once CCS starts, verify that the perspective is set to CCS Edit.
3  Import the project.
3a Select the CCS menu option Project = Import Existing CCS Eclipse Project

3b Set Select search directory to point to where the project files for this exercise are located on
your computer.

3c From the list of Discovered projects, place a check mark in the box next to SRIOSingleSRIO
3d Place a check mark on Copy projects into workspace.
3e Click the Finish button.

End of Procedure 4-1

Procedure 4-2 Build the Project
Step - Action
1 In Project Explorer, select the SRIOSingleSRIO project.

2 C(lean the project by right-clicking on the project and selecting Clean Build.
3 Build the project:
3a Select the CCS menu option Project > Build Project
OR
3b Right-click on the project in Project Explorer and select Build Project
4  CCSwill now attempt to compile and link the project. This may take a few minutes to complete.
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5  Verify that the executable (.out) was built by looking at the debug directory (assuming the build
configuration is debug configuration) as shown in Figure 4-1.

Figure 4-1 Verify Successful .out Build
[ ces Euit Code Composer Stodic N e

File Edit View Mavigate Project Run Scripts Window Help

£ - Kv o oA P [ %5 CCS Debug
[ Project Explorer £3 | [%) Target Configurations =% ¥ =0
+ 5 exampleTest -

= largeFIR_Energy
+ [Z5 SRIO_LoopbackDiclsrexampleproject
. i SRIOSingleSRIO [Active - Debug]
#¥ Binaries
! Includes
4 (= Debug

(= configPkg
[ah bichain.obj - [CE000/1e]
& bioUtilityAndGlobals.obj - [C6000/1e]
54 cppi_device.obj - [C6000/1e]
o device_srio_loopback.obj - [C6000/1e]
& fitRoutines.obj - [C6000/1e]
o gen_twiddle_fft16:16.0bj - [C5000/1]
[ initialization.obj - [C6000/1e]
[54 masterTask.obj - [C6000/1e]
o multicorel oopback_osal.obj - [C5000/1]
514 gmss_device.obj - [C6000/1e]
54 qmss_drv.obj - [C6000/1e]
[e14 requestProcessingData.obj - [C6000/1e]
5 slaveTask.obj - [C6000/le]
) srio_drv.obj - [C6000/1e]
) SRIOSingleSRIO.out - [C6000/1e]

m

bicMain.pp
bioUtilityAndGlobals.pp
[ cesObjs.opt
2 cesSres.opt
cppi_device. e
d:\;:lze,srm,l;;:pback‘pp B console 2 O B Ek1B-r5-"0
ftRoutines.pp CDT Build Console [SRIOSingleSRIO]
gen_swiddle f166.pp --cnd_file=". /configPkg/compiler.opt”™ "../srio_drv.c” A
‘Finished building: ../sric_drv.c’
initialization.pp b
& makefile 'Building target: SRIOSingleSRIO.out’
masterTask.pp "Invoking: C6@0@ Linker'
multicoreLoopback _osal.pp "C:/ti/ccs/cesvs/tools/compiler/c6@8@/bin/cl6x" -mv66@8 -g

--define=_LITTLE_ENDIAN --define=_TMS320C6600
--define=TMS320C668@ --diag warning=225 --abi=eabi -z
-m"SRIOSingleSRIO.map” --warn_sections

& objects.mk
qms_device.pp

qmss_drv.pp 1/tifces/cesv5/tools/compiler/c6008/1ib™
requestProcessingData.pp -i"C:/ti/ces/dsplib_c66x_3 8 8 _8/1ib"
slaveTask.pp -i"C:/ti/ccs/ccsvs/ tools/compiler/c6000/include” --reread_libs

& sources.mk --rom_model -c "SRIOSingleSRIO.out™ -1"./configPkg/linker.cmd”

. "./srio_drv.obj" "./slaveTask.obj" "./requestProcessingData.obj"
srio_drv.pp "./qmss_drv.obj" "./qmss_device.obj"

[5) SRIOMutticore fft_Lmap “./multicoreLoopback_osal.obi" *./masterTask.obj"

[Z] SRIOSingleSRIO.map “./initialization.obj" "./gen_twiddle_fft16x16.0bj"

& subdir_rules.mk ", /FftRoutines.o ./device srio_loopback.o

*./cppi_device.o ./bioUtilityAndGlobals.obj"
-1"libe.a" -ldsplib.ae66 “../ExampleSRIO.cmd™
~ || <Linking> v

@ subdir_vars.mk ./bioMain.cbj"

& subdir.mk

i Licensed 2 /SRIOSingleSRIO/Debug/SRIOSingleSRIO.out

End of Procedure 4-2

Procedure 4-3 Connect to the EVM
Step - Action
1 Cycle power on the EVM.

2 Click the Open Perspective (available right top corner of the CCS).

3 Switch to the Debug Perspective by selecting the CCS menu option Window = Open Perspective
-> CCS Debug.

Use the target configuration that you created previously.
5  Launch the target configuration as follows:

5a Select the target configuration .ccxml file.

5b Right click and select Launch Selected Configuration.

This brings up the Debug window.

7  Select all cores, right click, and group them by selecting Group Core(s) as shown in Figure 4-2.
The default name will be Group 1
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Figure 4-2

File Edit View Search Project Tools Run Scripts Window Help

CCS Debug: Select and Group Cores
1 CCs Debug - SRIOSingieSHIGsio e - Cooe Composer Sudic N e —

[l E%@-RH - A ¢ [# CCS Debug | B CCSEdit |
%5 Debug £3 | 4~ 5| € 7 = 0|0 Variables 52 |4 Expressions| 4 Registers| o [
a %) mazanin.carml [Code Composer Studic - Device Debugging] Name Type Value

[ Blackhawk XDS560v2-USB Mezzanine Emulator_ 0/C66c 0 (Disconnected : Unknowr) |

1 Blackhawk XDS560v2-USB Mezzanine Emulator_0/C66xc_L {Disconnected : Unknown) |

@ Blackhawk XDS560v2-USB Mezzanine Emulator_0/C66x0c 2 (Disconnected : Unknown) |

|8 Blackhawk XDS560v2-USB Mezzanine Emulator_0/C66x_3 (Disconnected : Unknowr) |

1 Blackhawk XDS560v2-USB Mezzanine Emulator_0/C66x_4 (Disconnected : Unknown) |

Enable Global Breakpoints
Enable Halt On Reset
Enable 05 Debugging
Open GEL Files View

3 Hide core(s)

Show all cores

Bl Console &2

Blackhawk XDS560,-2 1i1s2 Eranlator QOGS n Unknown) |
Blackhawk XDS5601 & Connect Target Ctrl+Alt+C  FUnknown) |
Blackhawk XDSS60\  Disconnect Target Ctr+ A<D | Unknown)|

Group core(s)

Ungroup core(s)
mazanin.ccml EEIpE)

C66xx_B: GEL OUTput: Se Rename...
C66xx_B: GEL Output: Se
Co6xx_1: GEL Output: Se
C66xx_1: GEL Output: Se
CB6xx_2: GEL Output: Se
Co6xx_2: GEL Output: Se
C66xx_3: GEL Output: Se
C66xx_3: GEL Output: Se
C66xx_4: GEL Output: Se
C66xx_4: GEL Output:
C66xx_5: GEL Output:
C66xx_5: GEL Output:

Remove All Terminated
Relaunch

Terminate and Remove

WL

Terminate/Disconnect All

Properties

Setup_Memory Map. ..
Setup_Memory_Map. .. Done.

[C6oxx75|"TTT s1ze’ 512 OUTPUT swwulswn real swww/Cww 1MAg 5UVYDCHD --cmd_tile="./contigPkg/compiler.opt™ “../sric_drv.c” -
[C6xx 2] fft size 128 output real imag 'Finished building: ../srio_drv.c'
[ce6xx_1] fft size 64 output 38001880 real S@BB7480 imag SPAE5488 O
[C66xx_6] fft size 32 output real imag 'Building target: SRIOSingleSRIO.out’
[ce6xx_1] fft size 32 output 500@l50@ real Seee7400 imag 80005400 'Inveoking: C600@ Linker'
[CB6xx_2] Fft size 64 output real imag "C:/ti/ccs/cesvs/tools/compiler/c6688/bin/c16x" -my66B8 -g
[C66xx_1] fft size 128 output 80001800 real 50007480 imag 50005400 --define=_LITTLE_ENDIAN --define=_TM5320C6600
[CB6xx_4] fft size 128 output B real imag --define=TMS328C6680 --diag warning=225 --abi=eabi -z
[Ce6xx_2] fft size 128 output real imag "SRIOSingleSRIO.map” --warn_sections
[Ce6xx_1] fft size 32 output 300018300 real 80007400 imag 80005400 - :/tifces/cesvS/tools/compiler/c6000/1ib™
[Ce6xx_3] fft size 256 output 5@@@288@ real S@BB7cBE imag B8BG5CE8 -i"C:/ti/ccs/dsplib_c66x_3_B_8_8/1ib"
[Ce6xx_1] fft size 512 output 50001300 recal 80007400 imag 50005400 - :/tifccs/cesvS/tools/compiler/c6@88/include” --reread_libs
[Ce6xx_2] fft size 64 output real imag 8 8 --rom_model -o "SRIOSingleSRIO.out” -1"./cenfigPkg/linker.cmd"
[CB6xx_a] Fft size 32 output real imag "./srio_drv.obj" "./slaveTask.obj" "./requestProcessingData.obj"
[C66xx_5] fft size 128 output real imag . /qmss_drv.cbi" *./qmss_devi bj
" /multicoreLoopback_osal.obj” "./masterTask.obi”
« "./initialization.obj" "./gen_twiddle fftl16x16.0bj"
Lo snan e g gt e AP
i_device.ol ./bioUtilityandGlobals.o ./bioMain.obji" —
| subdir_vars.mk herar —ldsplih.aeﬁﬁ "..IEKEiplESRIO_(md" ’ O
L& subdirmk - || <Linking> i
o Licenzed {2 /SRIOSingleSRIO/Debug/SRIOSingleSRIO. out
End of Procedure 4-3
Procedure 4-4 Load and Run

Step - Action
Select Group1 and connect all cores in the group:

1

1a From the CCS Run menu, select Connect Target.

OR

1b Right click on the group name and choose Connect Target.

OR
1c Click the Connect Target icon.

Load the SRIOSingleSRIO.out to all cores in the group:

2a From the Run menu, select Load.
OR
2b Click the Load icon
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3 Runthe code in one of the following ways:
3a PressF8
3b From the Run menu, select Resume
3c Click on the Resume icon (green arrow).
The output results appear as shown in Figure 4-3:
Figure 4-3 SRIOSingleSRIO Run Results

& cos vetus - o ool
File Edit View Search Project Tools Run  Scripts Window Help
5~ Ewe-Boe- B~ %~ -
#ﬁ‘[}ebugﬁﬁl ;- |:||]| =7 U |%,@|5@V=‘ﬁ
4 &% mazanin.caml [Code Composer Studic - Device Debugging]
a |3 Group1 |
s Blackhawk ¥D5560v2-USB Mezzanine Emulator_0/C66:0 0 (Running)
52 Blackhawk ¥D5560v2-USB Mezzanine Emulator_0/C66:0 1 (Running)
2 Blackhawk ¥D5560v2-USE Mezzanine Emulator_0/C66:0 2 (Running)
2 Blackhawk ¥D5560v2-USB Mezzanine Emulator_0/C66:0 3 (Running)
2 Blackhawk ¥D5560v2-USB Mezzanine Emulator_0/C66:0 4 (Running)
2 Blackhawk ¥D5560v2-USE Mezzanine Emulator_0/C68: 5 (Running)

52 Blackhawk XD5560v2-USE Mezzanine Emulator_0/C68x & (Running)
52 Blackhawk XD5560v2-USE Mezzanine Emulator_0/C68xe 7 (Running)

El Consale 23

mazanin.ccxml:CI0

[CeBxx_8] Debug(Core @): System Initialization for CPPI & QMSS
[CBBXK_B] === === mmmmmmmm e e e
[Ceexx_@] This is Core @, at this peint ALL cores finished create and bind
[Ceexx_1] fft size 64 cutput 588081588 real 80887408 imag 36085480
[Ceexx_2] fft size 64 ocutput 50802008 real B08B7388 imag 36885388
[Ceexx_3] fft size 128 output 3080825088 real 36867cB@ imag 38685cCE8
[Ceexx_1] fft size 32 output 50801508 real 20087406 imag 56605480
[CeBxx_2] fft size 256 output S8BE2008 real 50887588 imag 50085308
[CeBxx_1] fft size 256 cutput 88001302 real 50807480 imag 50005408
[CeBExx_3] fft size 128 output 380082502 real 50807c88 imag 50885ced
[Ceexx_4] fft size 256 ocutput 308@308@8 real Z0B0ERGRE imag 3ecec@E0
[CBAxx_5] fft size 512 output 38883588 real 30805488 imag 38086480
[CeAxx_3] fft size 512 output 208082508 real 36867c80 imag 3868588
[Ceexx_2] fft size 128 output 3080820068 real 36867360 imag 30685888
[Ceexx_1] fft size 64 ocutput 50801508 real S00B7408 imag 56005480
[Ceexx_B] fft size 32 cutput 50884000 real SEOBE508 imag SOQE6E0R
[CeBxx_1] fft size 32 cutput 50801880 real 50087408 imag 50085400
[Ceexx_2] fft size 64 cutput 50002002 real B0887508 imag 36005380
[Ceexx_1] fft size 128 output 38801588 real 360074808 imag 36085480
[CeAxx_4] fft size 128 output 38883888 real 30805288 imag 38086080
[Ceexx_2] fft size 128 output 3080820068 real 36867360 imag 30685888
[Ceexx_1] fft size 32 output 50801508 real 20087406 imag 56605480
[CeBxx_3] fft size 256 output 88882808 real 808087cEE imag B08B5CER
[CeBxx_1] fft size 512 cutput 88001302 real 50807480 imag 30005408
[CeBexx_2] fft size 64 cutput 5080820800 real 36087500 imag 50085308
[Ceexx_4] fft size 32 cutput 508030082 real B0823808 imag 30006080
[CBAxx_5] fft size 128 output 38883588 real 30805488 imag 38086480
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4  Observe the results, then suspend the run:
4a From the Run menu, choose Suspend.
OR
4b Click on the Suspend icon (the yellow “pause” lines)
End of Procedure 4-4
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Chapter 5

Optimization

5.1 Purpose

The goal of this exercise is to demonstrate some basic optimization techniques. This
exercise works on any KeyStone EVM board. It may also be used with the simulator in
conjunction with the estimated cycle count.

5.2 ProjectFiles
The following files are used in this lab:
o firMain.c
o intrinsicCFilters.c
e linker.cmd
o naturalCFilters.c
e testh
o utilities.c

5.3 Instructions

In the first part of the exercise, you will build, load and run a project on the EVM
without optimization. In the second part, you will enable optimization and analyze the
results.

The list of processes used in this example are as follows:
o Procedure 5-1 “Build and Run the Project”
+ Procedure 5-2 “Connect to the EVM”
o Procedure 5-3 “Load and Run the Program”
o Procedure 5-4 “Compiler Optimization™
o Procedure 5-5 “Enable Software Pipelining”
o Procedure 5-6 “Align the Data”
o Procedure 5-7 “Enable the MUST_ITERATE Pragma”
o Procedure 5-8 “Cache Considerations”
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Procedure 5-1 Build and Run the Project
Step - Action
1 Open CCS.

2 Create new project through the CCS menu item File > New - CCS Project.

3  Enter Optimization as a Project Name.

4  Click the check box to Use default location.

5  Setthe Family to C6000 and Variant to Generic C66xxx Device as shown in Figure 5-1:

Figure 5-1 CCS Project Settings
[F New CCS Project | B
CCS Project g

Create a new CCS Project.

Project name:  optirmization

Output type: | Executable V]

Use default location

Location: | ChUsershal270985 \WorkSpaces\temphoptimization Browse...
Device
Family: C6000 - |
Variant: <select or type filter texts ~ | Generic Chfwx Device v]
Connection:

b Advanced settings

= Project termplates and examples

type filter text Creates an empty project fully initialized =
for the selected device,

4 [Z] Empty Projects
| Empty Project |
& Empty Project (with main.c)
& Empty Assembly-only Project
& Empty RTSC Project

4 E Basic Examples
& Hello World

3 E IPC and I/0 Examples =

| »

m

@ < Back Mext = Finish l [ Cancel

Note—The screen shots may reflect different location for the project.
Then press Finish to create the new project.

7  Theninthe Project Explorer view, right-click on the newly-created optimization project, and click
on Add Files...

8  Browse to the project directory you created for this exercise and select all required files as
outlined at the beginning of this exercise, then click Open.
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9  When prompted how files should be imported into the project, leave it as default of Copy File.
Remove the main.c file that is created by default when you created the new project.

10  Examine the code in ‘firMain.c’ to understand the functions that are being called. The
generateData function generates the data sets to be operated on. Functions naturalCFilters and
intrinsicCfilters execute filters on the generated data. The former is implemented completely in
C, while the latter takes advantage of compiler intrinsics.

11  Setthe properties for the Debug configuration. Right-click on the project. Select Properties.
11a Choose Build, click on the Environment tab, and click the Add...button to add the path to

add a variable with Name as ‘PDK_ROOT' and Value as ‘C:\ti\mcsdk\pdk_C6678_1_1_2_5’
11b Choose C6000 Compiler = Optimization and set/verify the following properties:
« 'Optimization level = 0’
e ‘Optimize for code size = 0’
11c Choose C6000 Compiler 2 Debug Options and set/verify the following properties:
« ‘Debugging model = Full symbolic debug’
11d Choose C6000 Compiler = Include Options. Under the “Add dir to #include search path” add
the following two paths:
« "${PDK_ROOT}/packages/ti/csl"
« "${PDK_ROOT}/packages”
Note—This ensures that any include references in the project’s source files to header files
located at these paths will be interpreted accurately.

12 Click the OK button to save the project properties and close the Properties window.

13 Right-click on the project and select Build Project. A successful build will generate the following
output on the console:

<Linking>

'Finished building target: optimization.out'

**%% Build Finished #****

End of Procedure 5-1

Procedure 5-2 Connect to the EVM

Step - Action

1 Click the Open Perspective (available right top corner of the CCS).

2 Switchto the Debug Perspective by selecting the CCS menu option Window > Open Perspective
- CCS Debug.

3  Select the CCS menu option View > Target Configurations. Select the target configuration you
created

4  Launch the target configuration as follows:
4a Select the target configuration .ccxml file.
4b Right click and select Launch Selected Configuration.

5 This will bring up the Debug window.

5a Select Core 0 (C66x_0)
5b Right click and select Connect Target.

End of Procedure 5-2
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Procedure 5-3 Load and Run the Program
Step - Action
1 Enable the Clock by selecting the CCS menu option Run > Clock = Enable
2 Select Core 0 and load the .out file created earlier in the lab.
2a Select the CCS menu option Run - Load > Load Program
2b Click Browse project...
2c¢ Select optimization.out by unwrapping the OptimizationDebug and click OK.
2d Click OK to load the application to the target (Core 0).
3 Runthe application by selecting the CCS menu option Run - Resume.

A successful run should produce a console output as shown below. Record the cycles time for
both natural C and intrinsic C versions:

[C66xx 0] natural C code size 32768 time 3889442

[C66xx 0] intrinsic C code size 32768 time 2809073

[C66xx 0] no error was found !!!

[Ce6xx 0]

[C66xx 0]

[C66xx_0] DONE

Note—If the time shows zero, you have not enabled the clock (see above)

End of Procedure 5-3

Procedure 5-4 Compiler Optimization
Step - Action
1  Move back to the CCS Edit perspective.
2 Youwill now set the properties for the Release configuration. This suppresses all debug features
and enables the highest time optimization.
2a Right-click on the Optimization project. Select Build Configurations = Set Active = Release
3  Right-click on the Optimization Project. Select Properties.
3a Choose Build, click on the Environment tab, and click the Add...button to add the path to
add a variable with Name as ‘PDK_ROOT' and Value as ‘C:\ti\mcsdk\pdk_C6678_1_1_2_5'
Note—The path and platform may differ for your local devices.
3b Select C6000 Compiler 2 Optimization and set/verify the following properties:
¢ ‘Optimization level = 3’
3¢ Choose C6000 Compiler = Debug Options and ensure that:
« ‘Debugging model = Suppress all symbolic debug generation’
3d Choose C6000 Compiler 2 Include Options. Under the “Add dir to #include search path” add
the following two paths:
« "${PDK_ROOT}/packages/ti/csl"
« "${PDK_ROOT}/packages”
Note—This ensures that any include references in the project’s source files to header files
located at these paths will be interpreted accurately.
Click the OK button to save the project properties and close the Properties window.
5  Right-click on the project and select Build Project. A successful build will generate the following
output on the console:
<Linking>

'Finished building target: optimization.out'

*%%% Build Finished ****
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6  Enable the Clock by selecting the CCS menu option Run = Clock > Enable (if you have done in
the previous section of this lab, you can ignore this step).
7  Select Core 0 and load the .out file created earlier in the lab.
7a Select the CCS menu option Run - Load > Load Program
7b Click Browse project...
7c Select optimization.out by unwrapping the OptimizationRelease and click OK.
7d Click OK to load the application to the target (Core 0).
8  Run the application by selecting the CCS menu option Run = Resume.

9  Asuccessful run should produce a console output as shown below. Record the optimized cycle
times for both natural C and intrinsic C versions:

[C66xx 0] natural C code size 32768 time 228698
[C66xx 0] intrinsic C code size 32768 time 1282213
[C66xx 0] no error was found !!!

[Ce6xx 0]

[C66xx 0]

[C66xx_0] DONE

End of Procedure 5-4

QUESTIONS:
How much improvement is noted for the natural C code?

How much improvement is noted for the intrinsic code?

What issues exist within the code, if any?

Note—Consider how intrinsic functions utilize the processor.
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Procedure 5-5 Enable Software Pipelining

Step - Action

1 Inthe CCS Project Explorer go to Build - C6000 Compiler = Advanced Options = Assembler
Options and check the box that says Keep the generated assembly language (.asm) file

Rebuild the code.

The generated assembly file will be located within the Release directory since you are building
the project’s release configuration.

QUESTIONS:
Open the ‘intrinsicCFilter.asm’ file and answer the following questions:

«  Was the compiler able to schedule the software pipeline?

«  What are the general reasons that the compiler might not schedule the software
pipeline?

Note—Think about cases that can cause randomness in the execution timing.

« What reason can you see that the compiler might not be able to schedule the
software pipeline?

Note—Think about the inline function.

4  Replace the regular function with the intrinsic function in all the loops. Look at the definition of
the regular function and see what intrinsic it uses)

5 Rebuild the code, load, and run.
6  Look at the intrinsicCFilter.asm.
QUESTIONS:
Did the compiler schedule the software pipeline?

Record the optimized project cycles time for natural C function and for intrinsic
function with software pipeline.

End of Procedure 5-5
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Procedure 5-6 Align the Data
Step - Action

1 IntheintrinsicCFilter.c code, the data is read from the memory.
QUESTIONS:

o  What is the alignment of the input data?

o  What is the alignment of the filter coefficients (in the stack)?

Note—Find the pragma that aligns the data. Consider other ways to align the
data on a 64-bit boundary.

2 Changethe codeto tell the compiler that the datais loaded from aligned memory. (the _amemX
intrinsic tells the compiler that the data is aligned on 64 bit)

3 Rebuild the code, load, and run.

Record the optimized project cycle time for natural C function and for intrinsic function with
software pipeline and aligned load.

End of Procedure 5-6

Procedure 5-7 Enable the MUST_ITERATE Pragma
Step - Action

1 Uncomment the code to enable the pragmas that tell the compiler the minimum number of
iterations and the divisor.

Rebuild the code, load, and run

Record the optimized project cycle time for natural C function and for intrinsic function with
software pipeline, aligned load, and MUST_ITERATE pragma

End of Procedure 5-7.
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Procedure 5-8 Cache Considerations

Step - Action
1 In test.h, change the number of elements to 2K, 4K, 8K and 16K

2 In Table 5-1, record the cycle counts for each case.

Table 5-1 Clock Values & Cycle Counts

Size Multiply for 32K Clock Value Cycles for 32K
32K 1

16K 2
8K 4

4K 8
2K 16
End of Table 5-1

QUESTION:
Why the non-linear jump in performance?

Note—Think about cache trashing.

End of Procedure 5-8

5.3.1 Cache Analysis
QUESTION:

Think about the data size and the fact that float complex requires 8 bytes (single
precision). What is the actual size of the data?

Note—To understand better the cache issue, you should consider performing
the cache debug exercise in this document.

5.3.2 Change the Code to Speed Up to 32K
Change the code to increase the speed to 32K and take full advantage of the cache.

Note—Break the data into chunks and call each routine multiple times. Make
sure to keep the sum between calls as well as the pointer to the data.

5-8 TMS320TCl66x Keystone Multicore Workshop Lab Manual (BookiD: SPRP820/A)
Product Release: MCSDK 2.x



Chapter 6

Using Advanced Debug

6.1 Purpose

In the optimization exercise, the number of cycles is non-linear with the number of
elements. When the number of elements is 8K, the code is much faster than if the
number of elements is 16K; Per element, the numbers are normalized.

Recall that the data resides in L2 memory and that L1 D is configured as all cache. The
data is read from L2 memory and is put into the L1 cache for reusability.

The obvious explanation is that when the number of elements is 16K, the cache is
trashed during the first filter. So the second filter has a cache miss. The same is true for
the third filter and the fourth.

The elements in the optimization exercise are floating-point complex, single-precision
numbers. So each element requires 8 bytes; Single-precision is 32-bits, equal to 4 bytes,
and floating point complex doubles the number of bytes to 8.

In this exercise, you will use the debug features in Code Composer Studio (CCS) to
better understand the cache behavior and determine why the higher results start at 8K
and not at 4K.

6.1.1 Why the Debug Version is Used

For the purpose of reading data from L1 cache, the optimization is not important. This
would not be the case if the optimized code in the release writes out intermediate results
(and then reads it later) and the debug version does not. But this is not the case. Both
versions read and write the same information. Thus, for this exercise, the debug version
is used with non-optimization and full symbolic debug turned on.
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6.2 Instructions

First, you will look at the cache behavior when the number of elements is 4K. Next, you
will do the same with 16K elements. Lastly, you will look at the 8K elements use the
information derived from the previous two tasks to draw a conclusion.

The list of processes used in this example are as follows:
o Procedure 6-1 “View the 4K Case”
« Procedure 6-2 “Looking at the Cache Lines for 4K Case”
o Procedure 6-3 “View the Cache Lines for 16K Case”
o Procedure 6-4 “View the Cache Lines for 8K Case”

Procedure 6-1 View the 4K Case
Step - Action
1 Change the number of elements in the test.h file as follows:
#define NUMBER OF ELEMENTS 4096

2 Rebuild the code.

Launch the debugger, connect Core 0 to the emulator and load the code from the debug
configuration (the one with no-optimization and full symbolic debug).

From the Run menu in the Debug perspective, enable the Clock.
5  Open the file intrinsicCfilters.c and put a breakpoint after the first filter.
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6  Run the code and verify that it stopped at this breakpoint, which should appear as shown in
Figure 6-1:
Figure 6-1 CCS Debug: IntrinsicCFilters Breakpoint

e - LD~ O T e S
File Edit View Project Tools Run  Scripts Window Help

i g% Ees-BOér 4~
:’é’\‘DEhUg 23] 3% Ok = | e .ﬂ?| % he @| @9 T =8| REgi;ters|W=‘u’ariables ®g Break
a &% evmE78Trace.coxml [Code Composer Studic - Device Debugging] Tdentity Marne
a @ Groupl & - .
a ' Blackhawk XDS560v2-USB System Trace Emulator_0/C88x¢ 0 (Suspended - SW Breakpoint) 9, intrinsicCFilter Breakpoint

|= intrinsicC_filters(float *, int, float *)(} at intrinsicCFilters.c:47 0x0C0019F4 |
= (:20202020 (no symbels are defined for 0:20202020)
x@ Blackhawk XD5560v2-USE System Trace Emulator_0/C86x 1 (Disconnected : Unknown)
x@ Blackhawk XD5560n2-USE System Trace Emulator_0/Coe_2 (Disconnected : Unknown)
X® Blackhawk XD5560n2-USE System Trace Emulator_0/Ch6ie 3 (Disconnected : Unknown)
X® Blackhawk XD5560hn2-USE Systemn Trace Emulator_0/Ch6iec 4 (Disconnected : Unknown)
)
)
)

,P Blackhawk XD5560n2-U5B System Trace Emulator_0/C6Bx: 5 (Disconnected : Unknown
x@ Blackhawk XD5560v2-USE System Trace Ernulator_0/Co6x 6 (Disconnected : Unknown
x@ Blackhawk XD5560n2-USE System Trace Emulator_0/C66x_7 (Disconnected : Unknown

[8 testh | [E]_cint000 at /tmp/TIMKLIBWBzBI/SRC/boot.c87 0xc006720 | [¢) firMain.c  [€] intrinsicCFitters.c 52

35 ¥

36 1

37 total_sum
38 *output++

_hif2(sum) * _hif2(sum) + _lof2(sum) * _lof2(sum);
total_sum;

filter 1

Second filter, coefficients are (1/4 -1/4) (1/2 -1/2) (-1/4 1/4) (-1/2 1/2)
45 */
47 p_in = (_ float2_t *)inputComplex;
43 filter_size = 4;

58 x[8] = _ftof2(8.25, -8.25);

51 x[1] = _ftof2(e.5, -8.5);

52 x[21 = ftof2(-8.25, 8.25):
4

&l Console 52 I Memory Map| i3} Tabla| B Table| a Cache|

evmb678Trace.caml:CI0
|natural C code size 4896 time 481857

End of Procedure 6-1
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Procedure 6-2 Looking at the Cache Lines for 4K Case
Step - Action

1 Left-click on the View tab in the Debug perspective. In the pull-down menu, choose Other. A new
window will open, as shown in Figure 6-2.

Figure 6-2 CCS Debug: Show View
7 CCS Debug - optimization/intrinsicChiterse - Code Compose Studic W T

File Edit View Project Tools Run Scripts  Window Help

- ais- [BEra-Poe- 9~
35 Debug SX] 5% O = | 223D .ﬁ| v BT = 0O Registers||>‘]= Variab\es[oo Ereakpoil
4 ¥ evmB678Trace.coml [Code Composer Studio - Device Debugging] Identity Mame
4 &8 Groupl % .

4 ' Blackhawk XDS560v2-USB System Trace Emulator_0/CB6xc_0 (Suspended - SW Breakpoint)
intrinsicC_filters(float *, int, float *)() at intrinsicCFilters.c:47 0x0C0019F4
0x20202020 (no symbols are defined for 0::20202020)

[#] 8, intrinsicCFilter Breakpoint

X® Blackhawk XD5560v2-USB Systern Trace Emulator_0/Co6x 1 (Disconnected =t 3 ~
X® Elackhawk XD5560v2-USE Systermn Trace Emulator_0/C66c 2 (Disconnected '+ Show View E@M
@ Blackhawk XD5560v2-USE Systermn Trace Emulator_0/C66x 3 (Disconnected
2 Blackhawk XDS360v2-USB System Trace Emulator_0/C66:%_4 (Disconnected
x® Blackhawk XD5560v2-USE Systern Trace Emulator_0/C66x_5 (Disconnected b & General T
X® Elackhawk ¥D5560v2-USE Systern Trace Emulator_0/C66:c 6 (Disconnected - w
I+ = Analysis Views
X® Elackhawk XD5560v2-USE Systermn Trace Emulator_0/C66c 7 (Disconnected b C/Ces
4 [~ Debug =
®g Breakpoints r
Cache
Control Panel | 4
35 Debug
[H testh |E| _c_int00() at /tmp/TLMKLIBIwB281/SRC/boot.c:87 Oxc006720 | il | £ Disassembly
Z } {2 Executables
7 total_sum = _hif2(sum) * _hif2(sum) + _lof2(sum) * _lof2(s|| é’g 3:::”025
8 *putput++ = total sum; Ty browser
9 B MMU Page Table
2} I* =i Modules
1 # .End of filter 1 @ Pin Connect 8
2 *f
3
a4 r*
5 * Second filter, coefficients are (1/4 -1/4) (1/2 -1/2)
& */ [ ok [ cancel
7 _in = (_ fleat2 t *)inputComplex;
8 filter_size = 4; \
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2 Select Cache and double click to open the Cache window, as shown in Figure 6-3.
Figure 6-3 CCS Debug: IntrinsicCFilters Cache (4K)
[f testh | _c.int000 at ftmp/TLMKUBIWBZBUSRC/boot.c87 006720 | (4 firblaine | (6 ntrinsicCFitersc 33
}
lotal_sum = _hif2(sum) * _hif2(sum) + _lof2(sum) * _lof2(sum);
*output++ = total_sum;

=
* End of filter 1
w

e
* second filter, coefficients are (1/4 -1/4) (1/2 -1/2) (-1/4 1/4) (-1/2 1/2)
w

p_in = (_ float2 t *)inputComplex;

filter size = 4;

x[e] = _ftof2(s.25, -8.25);
x[1] = _ftof2(e.5, -0.5);
x[2] = ftof2(-@.25, 8.25):

{

2] Console‘ Memory Map‘ﬁ Tablel Cache l
(1) Cache Tag RAM Read complete: 1536 Cache Lines read from target (3 after filtering)
Cache Lin; Start Adrs lineEndAdrs  Set  Way Valid Dirty LRUWay Symbols InCache
L1D cache 0x00300000 0x00803FFF .., W - -
L1D cache 0x00808CC0o 0x00308DEF ... 1 W D L
L1D cache 0x00308F00 0x0080903F ... W D -
L1D cache 0x0080A000 0x0030A03F 128 1 W D L
L1D cache 0x0080A1CO Ox00B0AIFF 135 1 W - L " . " .
L1D cache Ox00B0AZED OOUBIAZEE 13 1 v R L ‘1 symbols (Double click to view (achelmedetalls].i
L1D cache 0x0080A300 0x0080A33F 140 0 ) D L
L1D cache 0x0080A440 0x0080A47F 145 0 ) D L
L1P cache 0x0C0005CH 0x0C0007DF 0 W
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3  Double-click on the Cache tab to enlarge the window. Then double-click on any line of the L1D
to display all L1D lines, as shown in Figure 6-4.

Figure 6-4 CCS Debug: IntrinsicCFilters L1D Cache Lines (4K)

£+ CCS Debug - Code Composer Studic NG s

File Edit View Project Tools Run  Scripts Window Help

ilhe A Hr Br@-Poer &~

El Console | Memory Map | FH Table I 3 Cache &2 l

(i) Cache Tag RAM Read complete: 1536 Cache Lines read from target (33 after filtering)

Cache Lin; Start Adrs Line End Adrs  Set  Way Valid Dirty LRUWay SymbolsIn Cache

L1D cache 0x00300000 0x0030003F a a v - - inputComplex (0x00800000)
L1D cache 0x00800040 0x0080007F 1 i} v - - inputComplex (+ 1Line)
L1D cache 0x00800030 0x008000BF 2 i} v - - inputComplex (+ 2 Lines)
L1D cache 0x008000C0 0x003000FF 3 1] v - - inputComplex {+ 3 Lines)
L1D cache 0x00800100 0x0080013F 4 i} v - - inputComplex (+ 4 Lines)
L1D cache 0x00800140 0x0080017F 5 1] v - - inputComplex {+ 5 Lines)
L1D cache 0x00800180 0x00B001BF & 1] v - - inputComplex {+ & Lines)
L1D cache 0x008001C0 0x008001FF 7 1] v - - inputComplex {+ 7 Lines)
L1D cache 0x00800200 0x0080023F 8 1] v - - inputComplex {+ 8 Lines)
L1D cache 0x00800240 0x0080027F 9 1] v - - inputComplex {+ 9 Lines)
L1D cache 0x00800230 0x008002BF 10 1] v - - inputComplex (+ 10 Lines)
L1D cache 0x008002C0 0x008002FF 11 1] v - - inputComplex (+ 11 Lines)
L1D cache 0x00800300 0x0080033F 12 i} v - - inputComplex (+ 12 Lines)
L1D cache 0x00800340 0x0080037F 13 1] v - - inputComplex (+ 13 Lines)
L1D cache 0x00800380 0x00B003BF 14 1] v - - inputComplex (+ 14 Lines)
L1D cache 0x008003C0 0x008003FF 15 1] v - - inputComplex (+ 15 Lines)
L1D cache 0x00800400 0x0080043F 16 1] v - - inputComplex (+ 16 Lines)
L1D cache 0x00300440 0x0080047F 17 1] v - - inputComplex (+ 17 Lines)
L1D cache 0x00800480 0x008004BF 18 1] v - - inputComplex (+ 18 Lines)
L1D cache 0x008004C0 0x008004FF 19 1] v - - inputComplex (+ 19 Lines)
L1D cache 0x00800500 0x0080053F 20 i} v - - inputComplex (+ 20 Lines)
L1D cache 0x00800540 0x0080057F 21 1] v - - inputComplex (+ 21 Lines)
L1D cache 0x00800580 0x00B005BF 22 1] v - - inputComplex (+ 22 Lines)
L1D cache 0x008005C0 0x008005FF 23 1] v - - inputComplex (+ 23 Lines)
L1D cache 0x00800800 0x0080083F 24 i} v - - inputComplex (+ 24 Lines)
L1D cache 0x00800540 0x0080067F 25 1] v - - inputComplex (+ 25 Lines)
L1D cache 0x00800630 0x008008BF 26 i} v - - inputComplex (+ 26 Lines)
L1D cache 0x008006C0 0x008006FF 27 1] v - - inputComplex (+ 27 Lines)
L1D cache 0x00800700 0x0080073F 28 1] v - - inputComplex (+ 28 Lines)
L1D cache 0x00800740 0x0080077F 29 1] v - - inputComplex (+ 29 Lines)
L1D cache 0x00800780 0x008007BF 30 1] v - - inputComplex (+ 30 Lines)
L1D cache 0x008007C0 0x008007FF 31 1] v - - inputComplex (+ 31 Lines)
L1D cache 0x00800800 0x0080083F 32 i} v - - inputComplex (+ 32 Lines)
L1D cache 0x00300840 0x0080087F 33 1] v - - inputComplex (+ 33 Lines)
L1D cache 0x00800830 0x008008BF 34 i} v - - inoutComplex (+ 34 Lines)

4  Examine the first L1D line. The address of the first L1D line is 0x0080 0000, which is the first line
of the L2 memory and where the input vector resides. Notice that the valid flag is set for this
cache line.
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5 Next, look at the last L1D cache line as shown in Figure 6-5:
o Thelast line of the vector inputComples is line 255 with a starting address of 0x0080 3fC0.

o After this, there are several DIRTY lines, which indicate where the code changed some
values.

«  Remember that L1D cache line has 64 bytes (0x40). So the last byte of inputComplex in the
cache is byte 0x00803fc0 +0x40 -1 = 0x00803fff. This is the Line End address of line 255.

Figure 6-5 CCS Debug: IntrinsicCFilters L1D Cache (Last Line, 4K)
¥ CCS Debug - Code Compaser Studic N

File Edit View Project Tools Run  Scripts Window Help
TS~ 35 v -ov&vag) G . A
El Console Memory Map BB Table B Cache 3
(1) Cache Tag RAM Read complete: 1536 Cache Lines read from target (33 after filtering)

Cache LinYe Start Adrs Line End Adrs ~ Set  Way Valid Dirty LRUWay Symbols In Cache

L1D cache 0x00303EC0 Ox00803EFF 251 0 v - - inputComplex (+ 251 Lines)

L1D cache 0x00303F00 Ox00803F3F 252 0 v - - inputComplex (+ 252 Lines)

L1D cache 0x00803F40 Ox00803F7F 253 0 v - - inputComplex (+ 253 Lines)

L1D cache 0x00803F30 Ox00803FBF 254 0 v - - inputComplex (+ 254 Lines)

L1D cache 0x00303FCO Ox00803FFF 255 0 v - - inputComplex (+ 255 Lines)

L1D cache 0x00808CC0 0x00808CFF 51 1 v D L

L1D cache 0x00808D00 0x00808D3F 52 1 v D L

L1D cache 0x00808D40 0x00308D7F 53 1 v D L

ERl DD0S0ED80 [ che line starts at 0:00808D4g) ¥ D t

L1D cache 0x00308F00 TRUUB0EF3F 60 1 W - -

L1D cache 0x00B808F40 Ox00308F7F 61 0 v D L

L1D cache 0x00808F80 0x00308FBF 62 0 v D L

L1D cache 0x00808FCO 0x00808FFF &3 0 v D L

L1D cache 0x00805000 0x0080903F B4 1 v D L _sys_memory {0x00309000)

L1D cache 0x0080A000 0x0030A03F 128 1 v D L _ftable (0x0080A000)

L1iD cache 0x0080A1CD 0x0030A1FF 135 1 v - L _ftable (+ 7 Lines, End: 0x008041DF), _stream (0x
L1D cache 0x0030A280 Ox0080A2BF 133 1 v - L _device (0x0080A230)

L1D cache 0x00304300 0x0080A33F 140 0 v D L __TI_enable_exit_profile_output (0x00804300),_m
L1D cache 0x0080A440 0x0080A47F 145 0 v D L _tmpnams {+ 5 Lines, End: 0x0080A45F), parmbuf
L1P cache 0x0C0005C0 0x0CO00SDF 46 0 v _oetarg_diouxp (0x0C0005CD)

L1P cache 0x0C0005ED 0x0CO005FF 47 0 v _getarg_diouxp (+ 1Line)

L1P cache 0x0C000800 0x0CO0061F 48 0 v _getarg_diouxp (+ 2 Lines)

L1P cache 0x0C000620 0x0CO0063F 49 0 v _getarg_diouxp (+ 3 Lines)

L1P cache 0x0C000840 0x0C00065F 50 0 v _getarg_diouxp (+ 4 Lines)

End of Procedure 6-2

QUESTIONS:
o What is the last cache line that has the inputComplex vector?

« How many bytes were read from the inputComplex vector?

«  What is the number of elements that were read from the inputComplex vector?
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Procedure 6-3 View the Cache Lines for 16K Case

Step - Action
1 Change the number of elements in the test.h file to 16K:

#define NUMBER OF ELEMENTS 16384

Repeat all the previous steps as defined in Task 1 and Task 2.

3 Build, load, and run the code to the break point. The cache lines should be the same or similar

to those shown in Figure 6-6:
Figure 6-6 CCS Debug: IntrinsicCFilters L1D Cache Lines (16K)

e e = e
I ¢S Debug - Cod

File Edit View Project Tools Run  Scripts Window Help

ilhe A Hr Br@-Poer &~

End of Procedure 6-3

El Console | Memory Map | B Table I E Cache 3 l

(i) Cache Tag RAM Read complete: 1536 Cache Lines read from target (989 after filtering)

Cache Lin; Start Adrs Line End Adrs  Set  Way Valid Dirty LRUWay SymbolsIn Cache

L1D cache 0x00808000 0x0080803F 0 1] v - L inputComplex {+ 512 Lines)
L1D cache 0x00303040 0x0080807F 1 1] v - L inputComplex {+ 513 Lines)
L1D cache 0x00308080 0x008080BF 2 1] v - L inputComplex {+ 514 Lines)
L1D cache 0x008080C0 0x008080FF 3 1] v - L inputComplex {+ 515 Lines)
L1D cache 0x002808100 0x0080813F 4 1] v - L inputComplex {+ 516 Lines)
L1D cache 0x00303140 0x0080817F 5 1] v - L inputComplex {+ 517 Lines)
L1D cache 0x00808130 0x00808 1BF [ a v - L inpuﬁﬂmﬂ'ﬁ'—f‘—‘—‘-"—‘-@“—"—
L1D cache 0x008081C0 0x008081FF 7 0 v - L inpy ?:rﬂlt’glosm tex (+ 517 Lirn
L1D cache 0x00B08200 Ox0080823F 8 0 1 - L input!#ﬂm!!"ﬁgrzmﬂﬂ_
L1D cache 0x00303240 0x0080827F 9 1] v - L inputComplex {+ 521 Lines)
L1D cache 0x002808280 0x003082BF 10 1] v - L inputComplex {+ 522 Lines)
L1D cache 0x008082C0 0x008082FF 11 1] v - L inputComplex {+ 523 Lines)
L1D cache 0x00808300 0x0080833F 12 1] v - L inputComplex {+ 524 Lines)
L1D cache 0x00308340 0x0080837F 13 1] v - L inputComplex {+ 525 Lines)
L1D cache 0x00808380 0x00B083EF 14 1] v - L inputComplex {+ 526 Lines)
L1D cache 0x008083C0 0x008083FF 15 1] v - L inputComplex {+ 527 Lines)
L1D cache 0x002803400 0x0030843F 16 1] v - L inputComplex {+ 528 Lines)
L1D cache 0x00303440 0x0080847F 17 1] v - L inputComplex {+ 529 Lines)
L1D cache 0x00303480 0x0030846F 18 1] v - L inputComplex {+ 530 Lines)
L1D cache 0x003034C0 0x003084FF 19 1] v - L inputComplex {+ 531 Lines)
L1D cache 0x00808500 0x0080853F 20 1] v - L inputComplex {+ 532 Lines)
L1D cache 0x002808540 0x0080857F 21 1] v - L inputComplex {+ 533 Lines)
L1D cache 0x00808580 0x003085BF 22 1] v - L inputComplex {+ 534 Lines)
L1D cache 0x008085C0 0x008085FF 23 1] v - L inputComplex {+ 535 Lines)
L1D cache 0x002808600 0x0080863F 24 1] v - L inputComplex {+ 536 Lines)
L1D cache 0x002808640 0x0080867F 25 1] v - L inputComplex {+ 537 Lines)
L1D cache 0x00308680 0x003086BF 26 1] v - L inputComplex {+ 538 Lines)
L1D cache 0x008086C0 0x00B3086FF 27 1] v - L inputComplex {+ 539 Lines)
L1D cache 0x00808700 0x0030873F 28 1] v - L inputComplex {+ 540 Lines)
L1D cache 0x00308740 0x0080877F 29 1] v - L inputComplex {+ 541 Lines)
L1D cache 0x00808780 0x003087BF 30 1] v - L inputComplex {+ 542 Lines)
L1D cache 0x008087C0 0x008087FF 31 1] v - L inputComplex {+ 543 Lines)

QUESTIONS:

«  Why does the first entry address start with 0x00808000?

o  What is the last cache line that has the inputComplex vector?

« How many bytes were read from the inputComplex vector? How do you know?

o What is the number of elements that were read from the inputComplex vector?
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Procedure 6-4 View the Cache Lines for 8K Case

Step - Action
1 Change the number of elements in the test.h file to 8K.

2 Repeat all the previous steps as defined in Task 1 and Task 2.
3  Build, load, and run the code to the break point.
End of Procedure 6-4

QUESTIONS:
Examine the cache.

o  Whatis the first entry address? What does it mean?

«  What is the last cache line that has the inputComplex vector?

« How many bytes were read from the inputComplex vector? How do you know?
«  What is the number of elements that were read from the inputComplex vector?

Finding the Bug
You should now understand that the number of elements as defined in test.h is not the
number of elements that are actually read from the input vector.

Can you suggest a bug fix in firMain.c that will fix the problem? Write your answer
below.
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Using MPAX to Define Private Core Memory in DDR

7.1 Purpose

A typical multicore scenario uses multiple cores to run the same code, but requires
different data and configuration structures.

Downloading the same execution code for multiple cores is very efficient. However,
since each core has its own configuration and data structures, these values must reside
in the private memory of each core; Namely, L2 SRAM or in L1D SRAM (if the
complete L1 D is not configured as cache).

However, the size of L2 is limited to 512K bytes for C6678, and 1024K bytes for C6670.
In addition, L2 is usually partitioned into L2 cache and L2 RAM, so that the available
L2 RAM size is smaller. In many cases, the amount of private data does not fit into the
available L2 RAM.

This exercise presents a simple way to configure part of the external DDR as a private
memory such that each core sees only its own data and structures.
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7.2 Overview
7.2.1 Short Description of MPAX (Memory Protection and Extension)
The C66x CorePac User’s Guide (Chapter 7.3) describes the MPAX unit. The MPAX
registers are used to translate a logical address (32-bit address) into a physical address
(36-bit address). In this example, translation registers are used to assign the different

physical address of each core to the same logical address. This that the same code will
load the same structures to different physical locations for each core.

The MPAX registers manipulations used to achieve the different translation will be
done in the main () function. The initialization of pre-initialized global variables (for
example, a declaration of global variable int x=6) is done before the start of main ().
Thus, pre-initialized global variables are not allowed in the DDR private memory.

Note—There may be way to configure the MPAX registers during boot, but this
exercise does not consider it.

7.2.2 Coherency Discussion

For cases where L1D is configured as a cache, there is hardware coherency between L2
data and L1 D inside the C66x CorePac. The hardware coherency guarantees that a
variable that is defined in L2 and is cache by L1D has the same value in both places.

This guarantee does not hold true with private memory in DDR. There is no hardware
coherency between DDR and the internal memory of the core — L2 and L1D. Thus the
user must maintain the coherency (using invalidate, writeback and writeback
invalidate).

This example solves the cache coherency problem by disabling the cache. Disabling the
cache is done using the MAR registers. The MAR registers are described in the C66
CorePac User’s Guide Chapter 4.4.

7.2.3 Usage of EDMA to Move Data to and from Private Memory

Data can be moved in and out of private memory using the EDMA. When a core reads
or writes to the DDR, the data goes via the master port of the core into the MSMC
through the core MPAX registers. When EDMA reads or writes data to the DDR, the
data goes via the TeraNet port. The TeraNet port that connects to the DDR has 16 sets
of MPAX registers that correspond to 16 privilege IDs. Each set has 8 registers. 8 more
MPAX registers are connected to the shared L2 memory inside the MSMC.

The privilege ID of EDMA transform is inherited from the master who initiates the
transform. So if Core 0 (with Privilege ID = 0) initiates EDMA transform, the privilege
ID is 0. If Core 7 initiates the EDMA transform, the EDMA privilege ID is 7.

If the EDMA is used with the DDR private memory, then the MPAX registers of each
privilege ID should be configured similarly to the core MPAX. In this example, EDMA
is not used.

7-2 TMS320TCl66x Keystone Multicore Workshop Lab Manual (BookiD: SPRP820/A)
Product Release: MCSDK 2.x


http://www.ti.com/lit/ug/sprugw0b/sprugw0b.pdf
http://www.ti.com/lit/ug/sprugw0b/sprugw0b.pdf
http://www.ti.com/lit/ug/sprugw0b/sprugw0b.pdf

DocID: 122222

7.2 Overview
Chapter 7—Using MPAX to Define Private Core Memory in DDR

7.2.4 Platform Configuration and the Memory Map

Projects that use RTSC must define the platform. The platform defines what memories
are used in the execution. In addition to L1, L2 and the MSMC memory, the external
memory DDR is defined.

Usually DDR is defined as 2G bytes memory (for the 6678 EVM). In the example, you
will reduce the size of DDR to 1G. You will then use the other 1G for private memories.

The default settings of the MPAX registers for all cores are as follows:

+ Register 0 value is 0000001E 000000BF -> correspondent to 2G mapping of
internal memory into itself

» Register 1 value is 8000001E 800000BF -> maps the 2G external memory 8000
0000 to fttt ffff into the 36 bit range 8 0000 0000 to 8 7fff fttf

» Register 2 value is 2100000b 100000£t -> Maps (again) 4K starting at address
0x21000000 to address 1 0000 0000. This is the DDR EMIF configuration
registers. Note that if the same memory range is defined in multiple MPAX
registers, the higher MPAX register translation is used.

» Registers 3 to 15 values are 00000000 00000080 which basically points to empty
memory regions.

In this example, the first DDR are divided into two parts:

o Ashared 256M DDR starting at logical address 0x8000 0000 to address Ox8fff fftt
— physical address 8 0000 0000 to address 8 Offf ffff

o A private 16M DDR for each core. The logical address starts at 0x9000 0000 to
0x97ff fttf with physical address depends on the core number as follows:

- Core 0 -> 81000 0000 to 8 10ff ffff
- Corel-> 811000000 to 8 11ff ffff
-  Core?2 -> 81200 0000 to 8 12ff ffff
- Core 3 -> 81300 0000 to 8 13ff ffff
- Core4 -> 81400 0000 to 8 14ff ffff
-  Core 5 -> 81500 0000 to 8 15ff ffff
- Core 6 -> 81600 0000 to 8 16ff ffff
- Core 7 -> 81700 0000 to 8 17ff ffff

To perform the translation, MPAX Register 4 will be used. The high 32 bits of the
register has the base logical address (5 bytes) and one minus the log (base 2) of the size.
Since the size of the private memory is 16M (2**24), the size is 23 or 10111b = 0x17.
Thus the high 32-bit of MPAX register number 3 should be 0x90000017 (bit 5 to 11 are
reserved).

The law 32-bit of MPAX 3 has the physical address (6 bytes) and 2 bytes of the
permission value. In this example, full permission values are given to the user and
Supervisor. Thus, the permission value is 0011 1111b or 0x3f.
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7-4

The physical address part of the law 32-bit depends on the core number. Based on the
values from above, the law 32-bits are

o Core 0 ->0x810000 3f
o Core 1-> 0x811000 3f
o Core 2-> 0x812000 3f
o Core 3-> 0x813000 3f
o Core 4-> 0x814000 3f
o Core 5-> 0x815000 3f
o Core 6-> 0x816000 3f
o Core 7-> 0x817000 3f

Note—Bits 6 and 7 are not used and may read as non zero.

The example configures the MPAX registers in two ways, either with CSL functions or
with direct register manipulations. The user can switch between the two ways (or even
use both of them). A printf shows the values of the MPAX registers.

7.2.5 MAR Registers

Next, consider the MAR registers. For this example, the logical memory starts on 16M
boundary and the size is 16M. So one MAR register controls the cache-ability of the
complete private memory (MAR registers control the logical addresses, not the physical
address). If the private memory was larger, multiple MAR registers will be used. And if
the logical memory boundary was not aligned on 16M bytes, a more complex scheme
has to be developed.

For the example case, the MAR registers disable the cache and prefetch for all addresses
starting in MAR 140 (0x9000 0000) to MAR 159 (0xa000 0000).

TMS320TCl66x Keystone Multicore Workshop Lab Manual (BookiD: SPRP820/A)
Product Release: MCSDK 2.x



7.3 Instructions
DocID: 122222 Chapter 7—Using MPAX to Define Private Core Memory in DDR

7.3 Instructions
The list of processes used in this example are as follows:
o Procedure 7-1 “Run the Example Code”
o Procedure 7-2 “Connect to the Non-debuggable Devices (Esp. CCTMS_0)”
o Procedure 7-3 “Load the Code to the 8 Cores”
+ Procedure 7-4 “Configure the CSSTM_0 Trace Control”
o Procedure 7-5 “Add and Configure the Trace Location”
» Procedure 7-6 “Start Display”
o Procedure 7-7 “Enable the Trace Point and Run”

Note—This exercise requires a mezzanine card with a trace emulator on the

target platform.
Procedure 7-1 Run the Example Code
Step - Action

1 Load MPAX_registerDemo from c:/temp/lab directory and look at its properties. Make sure that
all the relative paths exist in your system symbols.

2 Choose how you want to configure the MPAX register: using CSL or direct register manipulation
or both. Change the #if in two places to 0 or 1.

3  Rebuild the project.

Connect EVM6678 and start the debugger. Connect all the cores and load the code to all the
cores.

5 Runallthe cores. The printing will tell you when each core is done. A delay function staggers the
cores.

When all cores print the done statement they are all in infinite loop. Pause all the cores.
7  Repeat the following for each of the cores:

7a Select asingle core.

7b Open a memory view window (View-> memory).

7c Look at address 0x9000 0000 for all cores (This is external memory).

7d Core zero will have values start at 0, 1, 2, etc.

7e Core 1 will have values 0x0002 0000 and incrementing by 1.

7f  Core 2 will have the first value 0x0004 0000 and incrementing by 1.

79 Core 3,4,5,6,and 7 will have first values 0x0006 0000, 0x0008 0000, 0x000a 0000, 0x000c
0000 and 0x000e 0000, respectively.

Conclusion: The same logical addresses (0x9000 0000 and on) have a different physical
address for each core.

End of Procedure 7-1
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7.3.1 Using Trace to Verify the Write Physical Address

The next section describes how to use the trace facility to verify that each core actually
writes to a different physical address.

Procedure 7-2 Connect to the Non-debuggable Devices (Esp. CCTMS_0)
Step - Action

1 After launching the target, right-click on the upper line in the debug window (for example,
evm6678Trace.ccsml) and choose show all cores.

2 Goto non-debuggable devices (the bottom of the window), right-click, and connect to target.
3  Connectall the cores as well.
4  The debug window should appear as shown in Figure 7-1.

Figure 7-1 CCS Debug: MPAX Utilities

File Edit View Project Tools Run  Scripts Window Help
il #H BB - RO~ &~
%% Debug &2 ] |_v_ 3 |*,4$|@&v=5

a4 ¢ evmB678Trace.coxml [Code Composer Studio - Device Debugging]
4|7 Groupl

a o Blackhawk XD5560v2-USE System Trace Emulator_0/C68:0: 0 (Suspended)
0:20B01130 (no symbuols are defined for 0:20801130)
a4 o Blackhawk XD5560w2-USB System Trace Emulator_0/C68:0: 1 (Suspended)
020800248 (no symbols are defined for (:20B002A8)
ckhawk XD5560v2-U5E System Trace Emulator_0/CEw0 2 (Suspended)
0:20B002A8 (no symbols are defined for 0:20B002A8)
lackhawk XD5560v2-USE Systemn Trace Emulator_0/CoEw 3 (Suspended)
0:20B002A8 (no symbols are defined for 0:20B002A8)
ckhawk XD5560v2-U5E System Trace Emulator_0/C6w0 4 (Suspended)
0x20B002AE (no symbols are defined for 0x20B002A8)
lackhawk XD5560v2-USE Systemn Trace Emulator_0/CoEw 5 (Suspended)
0:20B002A8 (no symbols are defined for 0:20B002A8)
ckhawk XD5560v2-U5E System Trace Emulator_0/C86w0 6 (Suspended)
0x20B002A8 (no symbols are defined for (x20B002A8)
a o Blackhawk XD5560n2-USB System Trace Emulator_0/C68:0: 7 (Suspended)
0:20B002A8 (no symbols are defined for 0:20B002A8)
4 Maon Debuggable Devices

& Blackhawk XD5560n2-USE Systern Trace Emulator_0/TcePick_D

& Blackhawk XD5560v2-USB Systemn Trace Emulator 0/C5_DAP_DebugSss

& Blackhawk XD5560n2-USE System Trace Emulator_0/CS5TM_0

@ Blackhawk XD5560n2-USE Systemn Trace Emulator 0/ TETE_STM

[ [

= =

S8 S8
ne e

[ 9
=,
2
=
o

Y
=,
2

m

[ 9
=,
S
=
o

End of Procedure 7-2
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Procedure 7-3 Load the Code to the 8 Cores

Step - Action
1 To make the results easier, change the number of elements (Line 171 in testMPAX1.c) to 10.

2 Build the project again and load it o the 8 cores.
End of Procedure 7-3

Procedure 7-4 Configure the CSSTM_0 Trace Control

Step - Action

Note—These instructions are for CCS V5.3. For CCS V5.4 follow the instructions in Chapter 8 on
page 8-1.

From the Tools menu (in the debug prospective), choose Trace control.
The Trace System Control window (see below) opens. Click on the CSSTM_0 tab.

As shownin Figure 7-2, set Port width to 4 pin, place a check mark next to Synchronize with target,
set the buffer size (512kB is sufficient for this example), and select Circular buffer.

Figure 7-2 Trace System Control Setting

. ﬁ Trace System Contrel Ié
CSSTM_O | CBec_0 | CBBoc_1 | CBBo 2 | CBRoc_3 | CBRoc_4 | CBBoc_5 | CBRoc 6 | CBRec 7
Trace Settings

4pin - Port width m. Buffersize ¢ Stop-onful

¥ Circular

[+ Synchronize with target

About Data Viewer Receiver... oK Cancel Apphy
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4  Click on the Receiver... button to open the Select Receiver window as shown in Figure 7-3

4a Choose where the trace data will go. Choose 560 V2 Trace.

Note—You can use the EB as well, but the ETB is small (32K only) and then you have to read it

from the ETB.

4b Click OK on the dialogue box and then click Apply and wait for the programming to be

done.

Figure 7-3 Trace System Control Settings: Select Receiver

ﬂ' Trace System Control

CSSTM_D |CG&:::_1]| CEioc_1 | CBBec 2 | C8Goc 3 | CBBoc 4 | OB 5 | CBRec 6 | CBBec 7

Trace Settings

[pin <] Potwidth

512kB «| Buffersize " Stop-ondul
& Circular

¥ Synchronize with target

F
Select Receiver M

Blackhawk ¥D5560v2-USB System Trace Emulator_0/CSS5TM_0

560 Trace Fod
Pro Trace
None

About Data Viewer Receiver... QK

Cancel Aoply |

[

End of Procedure 7-4
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Procedure 7-5 Add and Configure the Trace Location

Step - Action
1 From the View tab, open a Breakpoint window.

Note—Trace points are currently (CCS5 version 5.3.x) defined from the Breakpoint window.
Load the code to all the cores.

From the Debug menu, go back and select the CSSTM_O trace.

Go to the Breakpoint window, right-click, and select Breakpoint.

u b W N

You can define either a breakpoint or a trace point. Select Trace point. A trace breakpoint will be
added to the window.

6  To configure the trace, right-click on the trace and choose Properties. The Breakpoint Properties
window is opened as shown in Figure 7-4:

Figure 7-4 Breakpoint Properties: Default Configuration
- - - _— b |7 S v
] | | - = = B || 14 Registers | €)= Variables | ®g Breakpoints £2 L 'l K% &8 LY |
=r Studio - Device Debugging] Identity Marne Cendition Count
[ 4 Trace Trace
I
«+ Properties for l ], |-
Breakpoint Properties & Breakpoint Properties - v v
Properties Values
4 Hardware Configuration
4 Type Trace
4 5TM Trace Type CP_Tracer
Transaction Monitor MSMZ_0
4 Function Transaction Statistics
- Statistics Type
Address Range Filter L] false
EMU Trigger Filter [ false
Sample Window 65535

- Display Settings
4 Miscellaneous
Group Default Group

=
MName Trace M
i
All settings under this are handled by the target without intruding on the target's execution Edit Propert
|C?:| OK ] I Cancel
TMS320TCl66x Keystone Multicore Workshop Lab Manual (BookID: SPRP820/A) 7-9

Product Release: MCSDK 2.x



7.3 Instructions
Chapter 7—Using MPAX to Define Private Core Memory in DDR DocID: 122222

7  To configure a Breakpoint Properties value, click on the value line to the right of the each value
to access a pull-down menu of options. The trace for this example is configured as follows:
7a STM Trace Type: CP_Tracer
7b Transaction Monitor: DDR3
7c¢ Function: Transaction Logging (This will open a new dialogue box to choose what to log)

7d Transaction Master ->GEM (Select only the GEM tab, this will open the next level — which
GEM to follow)

7e All GEMs should remain active. So select all the GEM from 0 to 7
7f At this point, the window appears as shown in Figure 7-5.

Figure 7-5 Breakpoint Properties: Example Configuration
+'r Properties for l_I_I—JEI |
Breakpoint Properties & Breakpoint Properties - - -
Properties Values =
Transaction Monitor DDR3
a Function Transaction Logging

4 Transaction Master

kit

SRIO_CPPI L] falze
a GEM i true
GEMO bl true
GEML bl true
GEM2 b true
GEM3 bl true
GEM4 b true
GEMS bl true
GEME bl true
GEM7 b true
GEMO CFG L] falze
GEML CFG [ false
GEMZ CFG L] falze

GEM3 CFG L] false

4 . »

All settings under this are handled by the target without intruding on the target's execution Edit Property

'(?:' [ oK ] I Cancel I

8  Scroll down in the window to Event Filter, Transaction Type, and set Only CPU access to true.
9  Export Configuration should be set to true for Status and New Requests.
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10  Address mask: In this example, you want to see the physical addresses. The trace can show only
10 bits of address. So you want to choose the right bits.

Of course, you can run the trace multiple times with each trace covering a different set of bits.
All of the writes are into DDR3 and that the physical addresses always start at 8 IN00 0000
(where N is the core number). So the 10 bits that you are going to choose for this example are
as follows:

e Bit 29: Expected to be always 0.

o Bit 28: Expected to be always 1.

o Bits 27 to 24: Expected to be the core number.
«  Bits 23 to 20: Expected to be all zeros.

Click on Export Bits. In the pull-down menu (see Figure 7-6), choose 29:20:

Figure 7-6 Breakpoint Properties: Address Mask Export Bits
'« Properties for = £
Breakpoint Properties & Breakpoint Properties - - w
Properties Values
4 Transaction Type
CPU Data Access ¥ true
CPU Instruction Ac [] false
DMA Access [ false
Access Type Any
4 Export Cenfiguration
> Export Access Status 7] true
» Export New Request By ] true
Export Last Burst Event [ false
Address Mask Export Bits 29:20 -
4 Address Range Filter Export Bits 26:17 -
» Start Location EF'U: g':s g;ig Il
Address Btension
» End Location Export Bits 30:21
Exclusive Address Export Bits 31:22
EMU Trigger Filter Export Bits 32:23 H
4 Miscellanecus Export Bits 33:24
Export Bits 34:25
< Export Bits 35:26 |
Set the 10 bit of the address associated with|Export B!ts 36:27 L
Export Bits 37:28 r
Export Bits 38:29
Export Bits 33:30
Export Bits 40:31
- Export Bits 41:32 £
@J Export Bits 42:33 |
Export Bits 43:34 B
— Export Bits 44:35 =
3 Duration: Summary - ALL B Cache EEE: g::: :égg i
— Export Bits 47:39 -
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11 No other filtering will be used. So both the Address Range Filter and EMU Trigger Filter should
be marked false. Click OK.

12  The Breakpoint Properties window should now be configured as shown in Figure 7-7

Figure 7-7 Breakpoint Properties: Example Configuration Complete
| e e 1 |
Breakpoint Properties & Breakpoint Properties - v -

Properties

Values
TE S5 [] false

4 Event Filter

4 Transaction Type
CPU Data Access ] true
CPU Instruction Ac [] false
DMA Access [] false
Access Type Any

4 Export Configuration

. Export Access Status ] true
> Export Mew Request By ] true
Export Last Burst Event [] false
Address Mask
Address Range Filter [ false
EMU Trigger Filter [] false

4 Miscellaneous

Group
Mame

Default Group
Trace

Export Bits 29:20

m

<

m

G

All settings under this are handled by the target without intruding on the target's execution Edit Property

@j 0K ] [ Cancel ]

End of Procedure 7-5

Procedure 7-6
Step - Action

1 From the Tools menu on the Debug perspective, choose Trace Analyzer, then Open Trace
Connection, and select Blackhawk XDS560v2-USB System Trace (or your emulator) as shown in
Figure 7-8:

Start Display

Figure 7-8

wasr au

Choosing the Trace Analyzer

Tools | Run  Scripts  Window Help

Pin Connect & 5} | %55 CCS Debug | B
Port Connect L

| v o5 | €3 7 T O || il Registers | B9- Variables | 9 Breakpoints 7% Cdl % & | =
Save Memory ging] - ] —

Load Memory
W20 0 (Suspended)

Fill Memary
49 RTOS Object View (ROV)
[ RTOS Analyzer b [twas reached) 3
W01 (Suspended)
[ System Analyzer 3
Graph 3
il Grap it was reached) Bl
£ Image Analyzer 20 2 (Suspended)
Profile 3
Trace Analyzer 3 Open Trace Connection In New View 3 <Blackhawk XD55600v2- USB System Trace Emulator_0/C66: 0 is not traceable>
Trace Control Open Trace File In New View... Blackhawk XDS560v2-USE System Trace Emulator 0/CSSTM_0
P R Open Trace Connection v [
A TeemE

2 The Trace window will appear.
End of Procedure 7-6
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Procedure 7-7

Enable the Trace Point and Run

Step - Action

1  Ifyou have not already done so, enable the Trace point in the Breakpoint window.

Run the code on all 8 cores.

2
3 Wait for the printfto verify that all cores are done.
4

Stop Run on all of the cores.

It may take several seconds for all the data to get into the CCS. Once it is there, the results will

appear as shown in Figure 7-9.

Trace Results

Figure 7-9
B e bebg o Srud
File Edit View Pregect Took Run Scrpts Window Help

- @ a-Dod- &~

3 Debug 2 ANl SR AL R
« B9 ere6TTract.caml [Code Composer Stdio - Device Debuaaing]
2 B Groupl

2 P Blackhowk XDS560:2:UISE Syeterm Toace Ermaleten 0/ Chlien 0 (Suspended)
= stayl) 1 MABY_sbibtses <17 0080150
enainl) ot besthAPAXD €1 TH DaD0E01E94
= e nt000) o bect.e173 GOEISHCE (the eritry pemei was reached]
4 P Blackhawk XOSS6042-USE Systern Trace Emulates 0/CBe 1 (Suspended)
Aayl) 3t MARX_utiities. 22 (MO0B01820
= main(] at testMPAD €178 0001854
= _cin00) ot boot.c:173 IBISBCE (the entry paint was resched)
& o Blackhawk KDSS60:2- IS8 System Trace Emulstcr 0/CBExx 2 {Suspended)
= stayl) ot MAPY_utifities.c22 (0801840
= main() at testMPAX]L:178 (nD0B01854
= _cintd00) # boct.:17] 00S050CH (the entry poant was reached)
@ o Blackhawk XDS56002-USE System Trace Dmulater 0/ Ch6_3 (Suspended)
= el s WAADY a0 ORI ANE

A5 teMPAXL e D
L wpaRLSK W G
i spaxl.ow = 1
spaxl. sr = 1;

129 e = (BLO + corelum * Gwdl) «c 12 3
~ printvalusinsigned (e} :
131 spaxl.ridde = xx

CHL_0_set0PANL (index, Lmpaxl);
printPAXDneRegistersi4)

139 Sendif
i1
LuMarPte = {volatile uint32 t*}0xB8000020;

B Consale Il | BF GEL Fikes | B Table| BB Durstice: Summary - ALL| [ Cache
el T Toace.coambCI0

[eo6o_3] Unsigned value -> 00813004
[CS60c_2] Unsigned Value -» 98514000
[CS60c_5] Unsigned Value  -» 8515000

[C86xx_3] MPAX register 4 -3 S13000bF 90080817
i » E1300861 S008001T

[Ctiax_3] MRAX register 4 - S13000b1 SHe0HLT
[Tl 4] MPAX register 4 -> B14000bF D0000017
[C66oc_5] MPAX reglster 4 -> 815000bF 90000017
[c66oc 3] Core 3 is Done  -» 3
[C660c 2] Core & &5 Done  -» &

0 R Ucensed

or logical sddress Ox9000 000D to OxOFHf Fiff 4

B || M Begaters #9° Varables | ®a Breskpounts £

B9 |85 CCS Debug | T CCSEdie

AR X T S RNl

w il B~y

=

Data Message .

Hew Request; Mas
Mew Request Mis
Hew Request Mas
Mew Request: Mas
Mew Request Mas
Hew Hegquest: Mas
Mew Request Mas
Hew Hequest; Mas -
0

7 B —

=11 ] ¥ =] IS8 System WM 5
Shevwing 162 Samples (sl data) | Stopped by user: uplcad complete | Recehver Clock 87.5 Mbz, Trace Deta Rate: 20 0143875 =

& ,@]n v 5| s
Deha Time Time Function Stat  MasterID  Master Name  Channel Number Module
0 ]

3 3 L 128 CPTeacer CPT

] 8 ] 128 CPTracer BT

5 ¥ L 128 CPTeacer oPT

[ 19 ] 12 CPTracer BT

5 n L 128 CPTeacer oPT

3 n ] 1 CPTeseer <P

L] n L] 128 CPTracer CPT

5 £l ] 18 CPTeseer <P

- =0

5 Double-click on the Trace Display window to enlarge it as shown in Figure 7-10. Focus on the
central part of the window and notice how each core writes to a different physical address:
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Figure 7-10 Trace Display Results: Core Details

Master=GEMO: Write Access: XID=0x0: Addr=0:x100
Master=GEMD: Write Access; XID=0:1; Addr=0:100
Master=GEMO; Write Access; XID=0x2; Addr=0:100
Master=GEMO: Write Access: XID=0x3: Addr=0:x100
Master=GEMD: Write Access; XID=0wd: Addr=0:100
Master=GEMO; Write Access; XID=0x5; Addr=0:100
Master=GEMO: Write Access: XID=0w0; Addr=0:x100
Master=GEMD: Write Access; XID=0x7: Addr=0:100
Master=GEMO; Write Access; XID=0x8; Addr=0:100
Master=GEMO: Write Access: XID=0:2: Addr=0:x100
Master=GEMD: Write Access; XID=0xa; Addr=0:100
Master=GEMD; Write Access; XID=0xb; Addr=0:100
Master=GEMO: Write Access: XID=0xc; Addr=0:x100
Master=GEMD: Write Access; XID=0xd; Addr=0:100
Master=GEMO; Write Access; XID=0xe Addr=0:100
Master=GEMO: Write Access: XKID=0xf Addr=0:100
Master=GEMO; Write Access; XID=0x0; Addr=0:100
Master=GEMO: Write Access: XID=0:: Addr=0:x100
Master=GEMD: Write Access; XID=0x2: Addr=0:100
Master=GEMO; Write Access; XID=0x3; Addr=0:100
Master=GEMI: Write Access: XID=0x2: Addr=0:110
Master=GEML; Write Access; XID=0:3; Addr=0:110
Master=GEML; Write Access; XID=0xd; Addr=0:110
Master=GEMI: Write Access: XID=0x5: Addr=0:110
Master=GEML; Write Access; XID=0wd; Addr=0:110
Master=GEML; Write Access; XID=0x7; Addr=0:110
Master=GEMI: Write Access: XID=0x8: Addr=0:110
Master=GEML; Write Access; XID=0:2: Addr=0:110
Master=GEML; Write Access; XID=0xa; Addr=0:110
Master=GEMI: Write Access: XID=0xb; &ddr=0:110
Master=GEML; Write Access; XID=0xc; Addr=0:110
Master=GEML; Write Access; XID=0xd; Addr=0:110
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6

Figure 7-11

Delta Time

The full Trace Display should appear as shown in Figure 7-11:

E-BPre-

& -

Time Function Start  Master [0 Master Name

o o
3 3 o 128 CPTracer
5 & o 1R CPTracer
5 13 o 128 CPTracer
(] 15 0 128 CPTracer
3 Fo 0 128 CPTracer
3 r 0 128 CPTracer
L 33 o 128 CPTracer
5 k-] L] 128 CPTracer
5 43 o 128 CPTracer
4 a o 128 CPTracer
5 53 o 1R CPTracer
5 s o 128 CPTracer
5 6 0 128 CPTracer
' o o 128 CPTracer
5 n 0 128 CPTracer
5 % o 128 CPTracer
6 82 L] 128 CPTracer
3 8 o 128 CPTracer
5 0 o 128 CPTracer
[ L) o 1R CPTracer
oM W0 o 128 CPTracer
5 WIS o 1R CPTracer
L nnas 0 128 CPTracer
5 nnM 0 128 CPTracer
5 RS o 128 CPTracer
4 Ny 0 128 CPTracer
5 Eon ket o 128 CPTracer
5 NS o 128 CPTracer
5 AT o 1R CPTracer
4 WTeE o 128 CPTracer
5 WNITE o 1R CPTracer
3 nrnare 0 128 CPTracer
11 Nz 0 128 CPTracer
E nnaEr o 128 CPTracer
5 nnx: 0 128 CPTracer
L anxe o 128 CPTracer
5 30T303 o 128 CPTracer
E EE o 1R CPTracer
[ ] nmnz o 128 CPTracer
End of Procedure 7-7
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Trace Display Results: Full Frame

Fle Edt View Pregeet Took Run Scrpli Wdow Help

. - [@=
1 Memary Brewser L ay - B A0SS
Snowing 162 Samptes (all data) | Stopped by user: upload complete | Receiver Clock §7.5 MHz Trace Duta Rates 2000145875 MHz

Dats Message

Hew Request; Masters GEMD; Write Access; XIDu () Addrs(hd00
Hiew Reqqest; Master= GEM; Wrte Access; XID=0l; Addr=0n100
Hew Request; Master= GEMD; Write Access: XD=0a2: Addr=0n100
New Reguest; Mavters GEMO; Wite Access; XID=0n3; Addr=(ad00
Mew Request Masters GEMD: Write Access: XD=0v: Addr=(h100
Hew Request Masters GIMO; Wiite Access: XID=(5; Addr=(d00
New Requeit: Master= GEMD: Wrde Accesa: XID=0db: Addr=0n100
New Request; Masters GEMD; Wiite Access; XIDaxT; Addr(hd00
Hew Requesk: Maters frite Acces: MD=0a6: Addr=0a100

Hiew Reqest; Master= GEMO; Write Access; D=0y 0100

Hew Request; Masters GEMD; Write Access: XD=(ndy Addr=0nd00
Hew Reguest; Masters GEMO; Wit Access; XID=0wc: Addr=(ad00
New Request; Master= GEMD: Write Azcess: XID=0wek Adr=0n00
Hew Request Masters GIMO; Wiite Access: XID=Owe: Addr=(hd00

Hiew Reqquest; Master= GEMI; Write Access; XID=03; Addr=0nd10
Mew Requests Masters GEML: Wrate Access: XD=0v: Addr=(ha10
Hew Request Masters GIML; Wiite Access: XID=5; Addr=0d10
New Requeit: Master=GEMI: Wrde Accesa: XID=0db: Addr=0h110
Hew Request Masters GIML; Wiite Access: XID=0u7; Addr=0ud10
Hew Requesk: Maters Wrde Acersic XID=0s: Addr=0:110
Hew Request; Masters GIM 3 3 hain
Hiew Reqpoest; Master= GEMI; Wrte Access; XID=0ux; 0110
Mew Request: Master= Gl Write Access: XID=Onky Addr=0:110
Hiew Request; Master= GEMI; Wrte Access; XID=lue; Addr=0nd10
Hew Request Masters GEML: Wrae Access: XID=0vek Addr=0u110
Hew Request Masters GIML; Wiite Access; XID=0we: Addr=0d10
New Requeit; Master= GEMI: Wrde Access: XID=0f: Addi=0x110
Hew Request Masters GIML; Wiite Access: XID=0u0; Addr=0d10
Hew Requesk: Maters Wirde Acersi; XID=0x1: Addi=0:110
Hew Request; Mast f1; Write Access; ¥IDsh: Addrs(ha10
Hiew Request; Master= GEMI; Write Access; XID=03; Addr=0nd10
New Request; Masters GEM; Write Access; XIDuld; Addr=(hd10

Lt '@ﬂ v | Steet

&y [R5 5 Debug ) () CC5 Ed

Dats  Domain

COR.
]
OOR.
DoR
[
DoR
]
DOR.
]
COR.
]
OOR.
DoR
[
DoR
]
DOR.
]
COR.
]
OOR.
]
[
DoR
]
DoR
]
COR.
]
OOR.
]
Do%
DoR
]
DoR
]
COR.
]
OOR.

-
Class .

Hew Request-GL
[y ——
Hew Request-GE
Hew Regquest-GE &
New RequestGE
Hew Raquest GL
Hew RequestGE
Hew Riequest GE
Hew RequestGE
Hew Request-GL
[ —
Mew Request-GE
Hew ReguestGE
New Request-GE
Hew Raquest GL
Hew RequestGE
Hew Request GE
Hew RequestGE
Hew Request-GL
[ —
Mew Request-GE
[ —
New Request-GE
Hew Raquest GL
Hew RequestGE
Hew RaquestGL
Hew RequestGE
Hew Request-GL
[ —
Mew Request-GE
[ —
New Request-GE
Hew Raquest GL
Hew RequestGE
Hew RaquestGL
Hew RequestGE
Hew Request-GL
[ —
Hew RequestGE ~
v

7.3.2 Additional Considerations

The time unit in the tracer is in tracer ticks driven from an 87.5MHZ clock. So
each time unit is 1/87.5 microsecond.

If the load is done when the trace is open, the trace will log the loading procedure.
To prevent this, load the code before configuring the CCSTM. If you want to run

the code again, load it again, and re-configure the CCSTM_0.

Play a little more with the CCSTM configuration to see what other values can be

traced.

Play with the address bits to see how they can affect the trace values.

If the trace file is large, you have to wait until after the system is stopped for the
data to reach the console. A percentage value will indicate how much of the trace
is already moved to the console (You will not see this in the previous example,

since the trace is short).

TMS320TCl66x Keystone Multicore Workshop Lab Manual (BookID: SPRP820/A)

Product Release: MCSDK 2.x



7.3 Instructions
Chapter 7—Using MPAX to Define Private Core Memory in DDR Doc ID: 122222

7-16 TMS320TCl66x Keystone Multicore Workshop Lab Manual (BookiD: SPRP820/A)
Product Release: MCSDK 2.x



Chapter 8

STM Library and System Trace

8.1 Purpose

The goal of this exercise is to demonstrate the usage of STM library to collect real-time
information into system trace and present it on CCS.

8.2 ProjectFiles
The following files are used in this exercise:
 Initialization.c
o StmMain.c
o System_trace.c
o System_trace.h
e TraceNoRTSC_I12.cmd
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8.3 Instructions
The list of processes used in this example are as follows:
o Procedure 8-1 “Build and Run the Project”
+ Procedure 8-2 “Connect to the EVM”
» Procedure 8-3 “Load the Program and Configure the Trace”
o Procedure 8-4 “Run the Program”

Note—This exercise requires a mezzanine card with a trace emulator on the
target platform.

Procedure 8-1 Build and Run the Project
Step - Action
1 Open CCS.

Create new project through the CCS menu item
File > New > CCS Project.
Enter stm_example as a Project Name.

Click the check box to Use default location.

A 1 A W N

Set the Family to C6000 and Variant to Generic C66xxx Device as shown in Figure 8-1:
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Figure 8-1

10
11

CCS Project Properties
&+ New CCS Project

CCS Project
Create a new CC5 Project.

-
' 2

Project name:

Output type: | Executable

[¥] Use default location

Laocation:

Device

ChUsers\al 270985\ WorkSpacesitemp

Browse...

Family: CB000

Variant: <select or type filter text>

Connection:

b Advanced settings

w Project templates and examples

type filter text

4 E Empty Projects
| & Empty Project|
[& Empty Project (with main.c)
[ Empty Assembly-only Project
[ Empty RTSC Project

4 E Basic Examples
[ Hello World

¢ =] IPC and VO Examples

| »

m

* | Generic Chfxe Device v]

Creates an empty project fully initialized =
for the selected device.

@ < Back

Press Finish to create the new project.

Mext = Finish

Cancel

In the Project Explorer view, right-click on the newly-created stm_example project, and click on

AddFiles...

Browse to ‘C:\ti\labs\code\STM,’ select all the files in this directory, and click Open. When
prompted how files should be imported into the project, leave it as default of Copy File.

If a file main.c was generated when you created the new project, remove the main.c file

Examine the code in ‘StmMain.c’ to understand the code.
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12  Location of the STM library

o The STMlibrary is part of MCSDK 3 release. If you have not installed MCSDK 3, you can get
the STM and all advanced debug library from the following address:

https://gforge.ti.com/gf/project/ctoolslib/frs/?action=FrsReleaseBrowse&frs_package_id
=92

» Ifyoudonot have MCSDK release, load the library from gforge address from above and put
it in directory ‘C:\tiMCSDK_3_0_0_11\ctoolslib_1_0_0_3\packages\ti\STMLib’

o Afterinstalling the STM library, the directory
‘C:\tiMCSDK_3_0_0_11\ctoolslib_1_0_0_3\packages\ti\STMLib’ includes multiple
sub-directories, as shown in Figure 8-2.

Figure 8-2 STM Lib Directory Structure
b OSDisk (C) » 6 » MCSDK 30112 » ctoolslib 1 020 » packages » ti » STMLib »

brary = Share with = Burn Mew folder

Mame Date modified Type
| doc 8/1/2013 3:40 PM File folder
J include 8/1/2013 3:40 PM File folder
., lib 8/1/2013 3:40 PM File folder
| projects 8/1/2013 3:40 PM File folder
| sIC 8/1/2013 3:40 PM File folder
2 | 5TMLib_5.0_Manifest.htm 2/5/2013 10:38 PM HTML Document

13 Setthe properties for the Debug configuration. Right-click on the project. Select Properties.

13a Choose Build, click on the Environment tab, and click the Add...button to add the path to
add a variable with Name as ‘STM_ROOQOT’ and Value as
‘C:\tiMCSDK_3_0_0_11\ctoolslib_1_0_0_3\packages\ti\STMLib’

13b Choose C6000 Compiler = Optimization and set/verify the following properties:
« 'Optimization level =0’
« 'Optimize for code size =0’

13c Choose C6000 Compiler = Debug Options and set/verify the following properties:
« ‘Debugging model = Full symbolic debug’

13d Choose C6000 Compiler 2 Include Options. Under the “Add dir to #include search path” add
the following two paths:

o "${STM_ROOT}/src"
e "${STM_ROOTVinclude”
Note—This ensures that any include references in the project’s source files to header files
located at these paths will be interpreted accurately.
14  Inthe linker tab, open file search path.

15  Add the following path ${STM_ROOT}Iib to the search path and the library stm.c66xx_elf.lib to
the library list

16  Click the OK button to save the project properties and close the Properties window.
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17  Right-click on the project and select Build Project. A successful build will generate the following
output on the console:

<Linking>
'Finished building target: .out'
*%%% Build Finished ****

End of Procedure 8-1

Procedure 8-2 Connect to the EVM

Step - Action
1  Click the Open Perspective (available right top corner of the CCS).

2 Switch to the Debug Perspective by selecting the CCS menu option Window = Open Perspective
- CCS Debug.

3 Select the CCS menu option View = Target Configurations as shown in Figure 8-3.
Figure 8-3 CCS Target Configurations

{7CS Debug - Code
File Edt View Project Took Run Scopts Window Help

M oW - L o (R C/C+ (B CCSDebug | B

5 Debwg | 0 Target Configurations 1 % M| & B 70| e vanables i |6 Expressions. BH Registers
T <k

& Projects
& User Defined

4  Use the target configuration that you created in “Preparations” on page 1-1. To create a new
target configuration, follow “Create a New Target in CCS” on page 1-2.

5  Launch the target configuration as follows:
5a Select the target configuration .ccxml file.
5b Right click and select Launch Selected Configuration.
6 This will bring up the Debug window.
6a Select Core 0 (C66x_0)
6b Right click and select Connect Target.
End of Procedure 8-2

Procedure 8-3 Load the Program and Configure the Trace

Step - Action

Note—These instructions are for CCS V5.4. For CCS V5.3 follow the instructions in Chapter 7
“Using MPAX to Define Private Core Memory in DDR" on page 7-1.

1  Select Core 0 and load the .out file created earlier in this exercise.
1a Select the CCS menu option Run = Load - Load Program
1b Click Browse project...
1c Select by unwrapping the stmSimpleExample—> Debug and click OK.
1d Click OK to load the StmSimpleExample.out application to the target (Core 0).

TMS320TCl66x Keystone Multicore Workshop Lab Manual (BookID: SPRP820/A) 85

Product Release: MCSDK 2.x



8.3 Instructions
Chapter 8—STM Library and System Trace

DocID: 122222

2 Asshown in Figure 8-4 select the top line in the debug window, right click, and select Show all

cores.

Figure 8-4

CCS Debug Trace Configuration: Show All Cores

File Edit View Project Tools Run

Scripts  Window  Help

[3 ~ B oW | = %
%‘5 Debug 3 ‘ %
4 |€';'= evmbbT8Trace.coxml [Code Co c - . Chrle AR+ C
4 3% Blackhawk XDS560v2-USB § onnect farge TR
= main(int)() at StrMain. Disconnect Target Ctrl+ Alt+ D
= _c_intd0{) at boot.c:87 0 Enable Global Breakpoints
xﬁ‘ Blackhawk ¥D5560v2-USE 5 Enable Halt On Reset W
xﬁ‘ Blackhawk ¥D5560v2-USE 5 ETE A HEE T T W
xﬁ‘ Blackhawk ¥D5560v2-USE 5 ] i W
o Blackhawk XDS560v2-Usg 5| ~ OPen GEL Files View w
Xﬁ Blackhawk XD5560w2-USE 5 % | Hide core(s) w
Xﬁ Blackhawk XD5560w2-USE 5 sh I w
& Blackhawk XDS560v2-USB § o all cores w

(€] 0x20b01130 Al StrMain.c 52
1 II..':-::-:

2
3/
4
5

L e e LR T R I e e

LI Sl e

Group core(s)
Sync group core(s)
Ungroup core(s)

Rename...

Remove All Terminated
Relaunch

Edit evmB6T8Trace.coxml...
Edit Source Lookup...
Terminate and Remove

Terminate/Disconnect All

Mo b im e

3  Non debuggable devices will appear as shown in Figure 8-5.

Figure 8-5

4  Select the Non Debuggable device group, right click, and connect Target. You notice that all

Non Debuggable Devices: Not Connected

4 3% MNon Debuggable Devices

@ Blackhawk XDS560v2-USB Systern Trace Emulator_0/TcePick_D
x@ Blackhawk XD5560v2-USE Systemn Trace Emulator_0/C5_DAP_Debugss (Disconnected)
ﬁ Blackhawk XD5560v2-USE Systemn Trace Emulator_0/CS5TM_0 (Disconnected)
;ﬁ’ Blackhawk XD5560v2-USB Systern Trace Emulator 0/ TETB_STM (Disconnected)

devices are connected as shown in Figure 8-6.

Figure 8-6

Non Debuggable Devices: Connected

4 &2 MNon Debuggable Devices
& Blackhawk XDS560v2-USB Systern Trace Emulator_0/TcePick_D

& Blackhawk XD5560v2-USE Systern Trace Emulator_0/C5_DAP_Debugss
& Blackhawk XD5560v2-USE Systermn Trace Emulator_0/CS5TM_0

& Blackhawk XDS560v2-USE System Trace Emulator 0/ TETE_STM
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5  Next, enable the Hardware Trace Analyzer as shown in Figure 8-7

Note—These operations are different in CCSV5.3. The screen shots in this example are from

CCSv5.4
Figure 8-7

Enable Hardware Trace Analyzer

EEXampierSTMMAIN.C - LOOE LOMPOSEr STAI0 I

t [ Tools | Run  Scripts  Window Help

&~

% % w B (ﬁv

“NIEE-

|%‘

ing]

Pick_D
| DAP_Debug55s
STM_0 (Disconnected)
B_STM |
0 (Suspended - 5W Breakpoint)
1 (Disconnected : Unknown)
2 (Dizconnected : Unknown)
3 (Disconnected : Unknown)
4 (Disconnected : Unknown)

Eim SR P |

Memory Map
— GEL Files
- Debugger Options 4
<m
bl Pin Connect
X Port Connect
X
X Save Memory
Xl Load Memaory
55 .

Fill Memo
s y
85\ & RTOS Object View (ROV)
350 b RTOS Analyzer v
55
55 i System Analyzer 3
55 t# Hardware Trace Analyzer 4
>3 i Graph »

ﬁ Image Analyzer

Profile »
t: XDAIS Tools »
' RTSC Tools v

Function Profiling - Not applicable on selected CPUs
Stall Profiling - Mot applicable on selected CPUs
Cache Analysis - Mot applicable on selected CPUs
Memory Throughput and Access Analysis

PC Trace - Mot applicable on selected CPUs

Custom PC Trace - Not applicable on selected CPUs
Custom System Trace

Open File

Analysis Dashboard

L

Impert Configuration...

fruntime/Log.h>

S L mm AL e an
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6  The Hardware Trace Analysis Configuration window appears, as shown in Figure 8-8.

Figure 8-8

Hardware Trace Analysis Configuration

+« Hardware Trace Analysis Configuration

e[S |-

Memory Throughput and Access Analysis Configuration

Graphs the memaory access throughput (MB/s) and//or
the number of bus cycles spent waiting to access memeory.

Name

Instrurnentation Type Cores

Memary Throughput and Access Analysis  System Trace C55TM_0

Transport Type
560 VZTrace -

» Receiver/Transport Settings
¢ Data Collection Settings

Advanced Settings

@ (o] (&

Start

||

Cancel

fruntime/Log.h>

TSRS S S

Open File

= Analysis Dashboard
= Import Configuration...

7  Chose 560 V2 Trace as the transport type, and click Start. Shortly, several windows will open.
Enlarge the Trace Viewer CSSTM_0 window.

End of Procedure 8-3

Procedure 8-4

Run the Program

Step - Action

1 Runthe application by selecting the CCS menu option Run > Resume.

2 The Trace Viewer CSSTM_0 window appears as shown in Figure 8-9.

Trace Viewer CSSTM_0

Stopped by buffer full : upload complete

Analyze |-E

Micro Secs

0.0000
0.0229
3.0971
45229
6.2400
8.5943
10.53711
13.57711
15.2800
16.6971
19.1200
21.0400
24.0800

Figure 8-9
L
BH *Trace Viewer - C55TM_0 &2 l
Tirme
1 0
2 2
3 m
4 422
5 546
6 752
7 922
8 1183
9 1337
10 1461
1 1673
12 1841
13 2107
14 2255

25.7714

End of Procedure 8-4

Master Mame

C66X.0
C66X_0
CB6X_0
C66X.0
C66X_0
CB6X_0
CB6X_0
C66X_0
C66X_0
CB6X_0
C66X.0
C66X_0
CB6X_0

Data Message Data Class

ivalue 2 Target function:
al 344 a2 86 Target function
a3 258 Target function:
End aIF changes Target function:
DOME number0 11! Target function:
ivalue 4 Target function:
al 144 a2 36 Target function:
a3 108 Target function:
End aIF changes Target function
DOME number1 ! Target function:
ivalue 6 Target function:
al 184 a2 46 Target function:
a3 138 Target function:

PutMSG()

: PutMSG()

PuthSG()

: PutMSsG()

PuthMSG()
PuthSG()
PuthMSG()
PuthMSG()

: PutMSG()

Puth5G()

: PutMSsG()

PuthMSG()
PuthSG()
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